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INTRODUCTION

The revolution in business caused by the internet and its related technologies shows
that information systems and information technologies are essential for the success of
business enterprises. With the rapidly charging technology, it is necessary to be in
continuous touch of it. It handles data and information represented in digital, text, image,
graphics or voice media and deals with communication, storage, pfocessing and printing.

Many Universities have introduced Information Technology at different levels of
education. In business, it is used for decision making. Therefore business students must
learn how to use and manage a variety of information technologies to revitalise business
processes.

A computer-is an electronic device whose basic function is the execution of
commands. A series of commands is known as a program. Now-a-days, a computer is
not limited only to computation. It can also be used for writing letters, maintaining data
base, listening songs, viewing movies etc. In this course we have discussed the application

of computers to business.



UNIT 1 AN INTRODUCTION TO COMPUTERS
Structure

1.1 Introduction

1.2 UnitObjectives

1.3 Meaning of Computer

1.4  Characteristics features of Computers
1.5°  Classification of Computers

1.6  Uses of Computers in Modern Society
1.7 Key Terms

1.8 Summary

1.9 Answers to Check Your Progress

1.10  Questions/Exercises

1.11  Further Reading

1.1 INTRODUCTION

Early people in small groups wandered from place to place in search of food.
They hunted animals and plucked fruits from trees for their sustenance. They had no
contacts with other groups. And also, their needs and wants were limited. Slowly, they
learnt the methods of agriculture. They domesticated some animals and made use of them
for various purposes. As days passed by, the needs of mankind increased. This
necessitated them to deal with other people and also with small amount of information.

As civilisation grew, their possessions and dealings with others considerably
increased. Many calculations had to be done for various purposes. This was the primary
reason for them to invent a machine that werld store information and make calculations.
After years of continuous research, man was able to construct the ‘COMPUTER’ a
calculating machine.

With the advent of Computer, world has now become oneness. It has been
occupying in all of our activities. It has become a part of our life. As such, everyone has to
acquire computer knowledge to face this modern world. Even at primary level of]
education, children are given computer education. All business activities are being

undertaken through computers. A man to compete with the present world must posses

computer knowledge. Without computer knowledge, he cannot face the world. This will| -

become areality very soon.

Computers have been installed in industries to operate machines and to control
quality of products. Business people use them for accounting, invoicing, stock coritrol and
payroll preparation. Railways and Air Corporations have employed computers to book
reservations. Computers have got a major role in diagnosing diseases in hospitals: They
keep records about the patients.
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1.2 OBJECTIVES

After going through this unit, you will be able to:
* describe *Ehe characteristic features of computers
« list the various classification of computers

« explain the uses of computers in the modern society.

1.3 MEANING OF COMPUTER

In the literal sense, Computer is a device that calculates. Initially the computer was
designed to perform certain arithmetic operations. It dealt with numbers only. However,
the present day computer can process both symbols and numbers. Therefore, the literal
interpretation of the word ‘computer’ is something a misnormer. In deed, the computer
can read input data, transfer data, store data and retrieve data, test data by logical
operations and provide results.

In this context, computer is defined as “A high speed electronic machine that
accepts input data, manipulates them and produces desired result as output”. Thus a
computer is an electronic device with the ability,

- to accept data and instructions by the users.

- to transfer or move data

- to store and retrieve data

- to perform arithmetic and logical operations and

-to produce‘ desired results in the desired form

Thus a computer is an electronic instrument which has the above capabilities. These

capabilities are usually called input, processing memory and output.

1.4 CHARACTERISTIC FEATURES OF COMPUTERS

The following are the characteristics of a computer.
1.4.1 Accuracy:

Computers are very accurate. Computers perform millions of operations every
second and can run errorless. This is because there is no human intervention between
processing operations. If at all it shows wrong result/information, it will be due to errors in
the supply of information by the user. Provisions 1ave been made to check the message
(data/information). Parity check code is introduced as in built to check the data. If the data
received is correct, then only transmission of data takes place. Thus, the results produced
by the computers are accurate. ‘

1.4.2 Speed:
The speed of a computer means the number of operation a computer can perform

in a second. It is to be noted that all computer operations are carried out by electrical



pulses. The clectrical pulses travel at a tremendous speed. The speed of computer may be
expressed in terms of seconds or no of operations. Generally, the speed is expressed in
terms of seconds or even milliseconds.

Millisecond . - One thousand of a second

Microsecond - One millionth of a second

Nanosecond - Thousand millionth ofa second

Picosecond - Million - millionth of a second

The speed of a computer is determined by clock rate. Clock rates are epressed in
MHz (Million of cycles per second). Now Pentium II with clock rates of 266 MHz, 300
MHz, 333 MHz, 350MHz, and 400 MHz are largely available. In 1999, Pentium IH with
the clock rates of 450 MHz/500 Mhz has been introduced.
1.4.3 Storage :

Computer stores large amount of information/data. Each computer has its own
internal memory in the CPU. The storage capacity of the memory unit is expressed in

-terms of kilobytes. The memory capacity of the computer can be increased through auxil-{

iary or secondary storage devices. They are magnetic disks, CD-ROM, magneto optical
devices, fixed devices and solid state devices. Disks store data drives cf 4GB, 9GB are
the currently available with maximum sizes. A single CD-ROM can contain 600 MB of]
data. Complex softwares like MS-Office ‘97, Visual ‘C’ or Visual C++ require over 100
MB Storage. Therefore they are distributed as CD-ROMs. Floppy disks are available in
1.4 MB capacity. The information stored in these devices can be quickly read or retrieved
whenever needed.

1.4.4 Versatility:

Computers can be used for any type of application. There is no limit for its appli-
cation. It can be used to solve any type of problém. An each it is a versatile machine.
1.4.5 Automation:

Computers have long been used in data acquisition and data processing. Now,
they are used in control systems also. Machine tools and industrial devices are controlled
by computers. Air Traffic control systems use computers. The automatic indusfry has
employed computers to test motors and other manufacturing operations. The industrial
robot is an outcome of the computer technology. Computers are now extensively used in
the quality control operations. In the present day, automated teller machines for disbursing
cash against credit cards is a good example of computer automation. A new class of
application known as office automation system is emerging very fast. This is due-to the
rapid developments in electronic communications system.

1.4.6 Diligence:

If a man starts working, he becomes tired after a few hours. But the computer
works for hours together. In other words, the computer is a machine which does not get
tired by doing continuous repetitive tasks. As it gives a series of continuous services, it
irrhlproves the quality of service of an organiéation and also the quality of human life.
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1.4.7 Reliability:
Since the results produced by the computers are accurate with high degree of

precisions, they are reliable.

1.4.8. Capability:
If a computer is programmed once, then the program can be executed as many

times as you need.

1.5 CLASSIFICATION OF COMPUTERS

Computer can be classified.

1.5.1. On the basis of generation

1.5.2. On the basis ot purpose for which they are used
1.5.3. On the basis of construction

1.5.4 On the basis of memory capacity

1.5.1 Computers on the basis of generations:

Based on the technology, computers are accociated to varios generations.
1.5.1.1 First Generation Computers (1946-1959)

Computers manufactured during this period, used vacuum tubes. The computers,
fitted with vacuum tubes, are called first generation computers. ENIAC was of this
category. This type of computers used 18000 vacuum tubes, weighed 30 tones and
occupied a very large hall. The following are their characteristics:

» Large insize \

» Slow operating speed

¢ Consumed high power

« More costlier

» Memory capacity=4096 words

« No provision to handle subprograms

« Unable to handle programming logic and non numeric problems
e Only 10 input, output instructions available -

e Short life span.

Example of this category ENIAC, EDVAC, EDSAC, IBMMARK-I, UNIVAC,
and so on. .
1.5.1.2. Second Generation Computers (1960-1964)

The second generation computers used transistor in the place of vacuum tubes.
The transistors was 1/10 the size of a valve. A transistor could do the same operation
1/10,00,000 of a second, which a first generation computer did in 1/3 of a second. During

this period, certain hi gh level languages such as BASIC, COBOL, FORTRAN, ALCOL

were developed. For storing data and programs, magnetic disks were developed. It
consumed little energy, and generated very less heat. It becames smaller, faster and had
greater computing capability.



During this period, system software like compliers, subroutine libraries and batch
monitors emerged. The following are their special features:

. Less power consumption

. Less expensive

. High speed of operation

. Lessheat
1.5.1.3. Third Generation Computers (1965-70):

The Computers, built during this period, used ‘Integrated Circuits’ (IC). An inte-
grated circuit, in the form of chip, consists of more than 300 transistors. The use of IC’s
improved the auxiliary storage devices and input/output devices. These devices increased
the data processing speed. Multi-processing and multi programming were made possible.
The use of integrated circuits lead to drastic reduction in physical size and cost. Full pledged
operating systems were introduced for automatic sharing of resources of the computers.
1.5.1.4 Fourth Generation Computers (1971 Onwards):

1972 is aremarkable year in the history of computer. Computers were made up of]
very large-scale integrated circuits (VLST). A large scale integrated circuit contains nearly
10000 transistors grouped in a single silicon chip known as Microprocessor. VLSI based
computers are called Micro computers. A computer is called micro-computer for two
‘reasons.

i) It contains a micro processor and

if) It is small in size (ie.) miniature

Micro computers gave rise to a new class of general purpose machines called
Personal Computers’ (PC). A typical micro computer could be placed on a desk.

MS-DOS aperating system of Microsoft Corporation was used as the control
program, Now-a-days, MS-DOS is widely used in PCs. Amyriad applications software
such as Wordstar, Dbase Il plus, Lotus 1-2-3 and the like could be easily run on these
machinesﬁvith powerful RAM capacity of 64 MB, Packages like ORACLE, SYBASE,
POWERBUILDER, VISUAL BASIC and the like can be loaded and run. Multi-Media
applications are special features of these powerful Micro-Computers.

In a further development, keyboard has been supplemented by the mouse, as an
- additional imput device. To add, CD-ROM (Compact Disk Drive) is another innovation
during this period. The Pentium processor was introduced in 1993. Intel P1 processor
was introduced in 1995, with 133 MHz. Pentium Pro at 200 MHz came into the market.
Pentium II (Pentium Pro and Unix) with 233 MHz was introduced in 1998.
1.5.1.5 Fifth Generation Computers (Yet to come):

Upto fourth generation, computers have dealt with numbers and characters. Now
efforts are being undertaken to make the computers store and process knowledge. These
computers will think and take decisions and in certain cases better than human beings.
These computers will be endowed with artificial intelligence. The main goal of Al is to
replicate human processes using chips. In Japan, they have already started their project in
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1981. They call the machines as knowledge information processing systems (KIPS). KIPS
will work as amplifier of human thought and intelligence. It is expected by all that the fifth

generation computers will be commercially available in the 21 century.
1.5.2 Computers on the Basis of Construction
On the basis of construction and working, computers can be classified into:
. 1) Digital Computers
ii) Analog Computers
iii) Hybrid Computers
1.5.2.1 Digital Computers

A computer that operates by counting is called a digital computer. Digital computers
operate on discrete quantities. Both numeric and non-numeric information are represented
in the form of numerical digits. They use binary codes Os and 1s to represent information.

All operations are preformed on the basis of addition. These computers can be used in all
fields.

i.5.2.2 Analog Computers:

A computer that operates by measuring is called analog computer. Analog computer
measure continuously varying quantities like voltage and current. The problems are covered
into equations and then to electrical signals. They give results in the form of graphs. They
are useful for scientific purposes only. These computers cannot process alphanumeric
information.
1.5.2.3 Hybrid Conhputers

The computers, which possess the features of both digital and analog are called
Hybrid computers. In such computers, some calculations are done in the analog portion of
the computer and some are done in the digital portion of the computer. In a hospital intensive

care unit, in the digital portion, reports are preparéd on the basis of data available in the

analog portion.

Differences between a Digital Computer and an Analog Computer:

Digital Computer Analog Computer

i) It Operates by counting It operates by measuring

ii) It is concerned with discrete quantities. It is concerned with continuous
quantities.
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iv) The calculations are first converted The calculations are converted into into
binary numbers equations and then into electrical

signals
v) The output is in the form of discrete values. The output is in the form of graph.
vi) More accurate Less accurate.
vii) More memory is available. Limited memory is available.
viti) High speed. Less speed.
ix) Highly Flexible Lacks flexibility. CHECK YOUR PROGRES

Fill in the blanks

. L. L. 1. The speed of the computer
"X) Vast applications Limited Applications. is measured in

2. The main component of
the first generation compuier

xi) It can process alphanumeric information It cannot process alphanumeric is
. . Say True or False
information 3. Computers has its own

memory memory in the CPU
. . 4. The Storage capacity of the
1.5.3 Computers out the basis of memory capacity memory unit is expressed in
: terms of units.

. . . . 5. Narno second is equal to
Computers can be classified into four types on the basis of memory capacity. > One thousand of 4 second

. b. one millionth of a second

c. Thousand millionth of a
second
d. one second.

(i) Micro Computer

(i) Minm Computer
(ii1) Ma.infra.lme Compute
4
(iv) Super Computer
1.5.3.1 Micro Computer
A computer is called Micro Computer because of two reasons
(i) Itissmallin size and

(i) It contains a micro processor.

In the micro computer, CPU is a microprocessor. A miCroprocessor 1S a processor
all the components of which, are on a single integrated-circuit chip. Its storage capacity is
low when compared to mini and main frame computers. The maximum word length (normally
16 bits) Varies according to the configuration of the computers. It accepts most of the high

level languages. It is relatively less expensive.
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Micro-computers can be sub-divided into two types.

Home Computers:

Home compuiters are meant for entertainment, education and training. The keyboard
of a home computer is integrated with CPU and the computer is interfaced with ordinary
television. Vendors supply cassette tapes containing program for computer games and

entertainment. Apart from this, several built in functions are available.

Personal Computers:

Since personal computers are designed for personal use of individuals/small business
concerns. they are called so. They are meant for professionals, small business unit and

office automation systems. They can be used for a variety of applications.

1.5.3.2. Mini Computers:

Third Generation Computers are minicomputers. Mini computers are multi-user
systems. They have multi-terminal facilities. It has only one central processing unit but has
many terminals and keyboards. It may be concurrently used by 20-40 users (The figure on
the number should not be taken in a strict sense) at a time. The size of a mini computers is
in between the size of a macro computer and main frame computer, It is more powerful
than a microcomputer. The first mﬁﬁ-computers were employed for scientific applications.
They play a major role in Computer Aided Manufacturing (CAM) and Computer Aided
Designing (CAD). These computers are mainly used in banks and medium sized organization
for data processing purposes.

1.5.3.3 Mainframe Computers:

Mainframe computers are physically larger than micros-or minis. They have large
primary storage capacity. A single machine can process several hundred different programs.
More than hundred users can use a mainframe simultaneously. They are used for the scientific
and engineering analysis, simulations of complex design projects, air craft designing etc.
They are usually used by major corporations, government agencies, international banks,

air lines, oil companies and national stock exchanges.
1.5.3.4 Super Computers :

Super computer is the most powerful of all computers as regards capacity, speed,
accuracy etc. It can not be compared with any other computers. They can process hundreds
of millions of instructions per second. The computing capability of a super computer is
equal to that of 40000 micro computers. They are used for applications such as weather
forecasting, nuclear sciénce research, and aerodynamic modeling and powerful simulations
in physics and university. The USA and Japan are the competitors in developing super
computers. Cray Research‘ (USA), Fujitsn (Japan) and Indian C-DAC (Centre for



development of Advanced Computing , Pune are the manufacturers of super computers.
The cost of super Computer is in the range of several crores of rupees. The Indian version
PARAM was developed by C-DAC with the governmental subsidy. |

PARAM 10000 has been installed, for the first time in the educational institution in
India, at Amrita Institute of Advanced Computing, Coimbatore in 1999.

1.5.4 Classifications on the basis of purpose for which they are used:
Computer can be classified according to the purpose for which they are used.
i) General purpose computers and
i) Special purpose computers
1.5.4.1 General Purpose Computer:

A digital computer is a general purpose computer. It is designed to perform a
variety of tasks from simple arithmetic calculations to generation of charts. In other words,
it can be used for both business applications and scientific applications. The computers

you come across in offices and other places are general purpose computers.
1.5.4.2 Special Purpese Computer:

A special purpose computer is one, which is designed to perform a specific job. In
such computers, all the instructions are in built. The given task is performed quickly and
efficiently. It cannot be used for any other task. As such, it lacks versatility. For example,
electronic volting machine, computer used for the reservations of tickets in the railway
station etc.

The micrometers are built around micro processor chips. It is possible to pack a

complete micro computer CPU on a single chip. However, several chips are usually used.
" One chip may oe used to perform arithmetic logic and control functions. RAM chips
handle primary memory storage function while micro computers are light enough to be
moved easily. They can be used by one personatatime.

1.6 USES OF COMPUTERS IN THE MODERN SOCIETY

In modern days computer has various applications viz., scientific and business
applications. Let us discuss some examples on business applications.

- 1.6.1 Payroll preparation:

To prepare the payroll of the employees, the following details are required.
Employees names, Employees number, Basic pay, Allowances and Deductions. All the

Antntln cven cbmvnd lin bl s vem b a BT L T qnsansanrtan wand e Aataile Fensan smmnotan f 1o aed
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Check Your Progress

Fill in the blands

6. A computer that operates

by measuring is

. computer

7. A digital computer is a
purpose

computer.

Say True or false

8. The output of a digital

computer is in he form of

graph N

9. Super computer is the

most powerful of ali

computers.

10..Super computer is the

most powerful of all

computers.

Choose the best

11. Computer has been

applied for

a) Payroll preparation

b) Inventory control

¢) Banking and insurance

calculates net pay. The program also prints out pay slips for each employees. The payroll

system also generates a number of statements.

11.6.2 Inventory Control:

Inventory n1anégement and control is the main determining factor of profitability of
the concern. The set of programs used to keep track of the purchase and issue of these
inventories constitute the ini/entory control system. The inventory control system maintain
“a file kn®wn as inventory master. When an item is issued or received, the inventory update

program updates the Inventory Master.
1.6.3 Sales Order Processing:

Real time system offer the possibility of a great prompt service to the customers.
Their orders can be processed within virtually no time. Besides the following functions can

be performance rapidly.

) The inquiries about the customer’s account status can be answered by the
salesman.

1) Credit appraisal can be carried out on-line.

iii) Sales analyse master file can be updated online.

v) Inventory replenishment orders can be determined as a part of the sales

order processing.

1.6.4 Banking:

Banks are the major users of computers. Opening of bank accounts, withdrawal
of money, maintaining the accounts are done with the help of the computers. In advanced
branches, payment are made automatically by the computer using Automatic Toller
Machines “ (ATM)/. Electronic Fund Transfer facilitates quick transfer of money from one

blace to another.
1.6.5 Insurance:

The Insurance industry uses computers to simplify the handling of administrative

| paper work. The computers produce a variety of external reports

1.6.6 Transportation:

Compiters are used in the transport system for cost analysis, accounting, calculation
of traffic rates, vehicle maintenance, reservation, etc. The railway and air reservation systems

are based on online applicaticns.




Computers are also used in other fields like Retail Stores, Government, Education,
Public utilities, Distribution, Health Care, Printing and Entertainment.

1.7KEY TERMS

¢ Vaccum tube

* Tranister

* Integrated Circuit

A thermionic valve

A small semi conductor electronic-device that is wed for
amplification and switching purposes.

A complete miniature electronic circuit that is fabricated

on a single chip of semi conductor, manufactured as a

single unit.

» Digital Pertaining to data that is in the form of digits.

* Analogue Pertaining to data that consists of continuously variable
Quantities.

» Hybrid A r‘nixed computer system in which analog and digital
computing devices are combined.

* Binary A numeral system with base 2.

1.8 SUMMARY

In this unit introduction about the computer has been discussed. Computer is an

electronic device which accepts input data, manipulates them and produce desired result

as output. Accuracy, speed, storage, versatility, automation, diligence, reliability and

capability are the characteristics of the computers. Computers are classified on the basis

of generation, purpose for which they are used, construction and its memory capacity. In

modem days computers are used for various applications viz., payroll preparation, inventory

control, sale order processing, banking, insurance and transportation. They are used in

retail stores, government, education, public utilities, healthcare, printing and entertainment.

1.9 ANSWERS TO CHECK YOUR PROGRESS

1) Nanosecond 2) Vacuum tubes - 3HT 4HF 5)C

6) Analog

7) General 8) False 9). True 10)D
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1-10 QUESTIONS/EXERCISES

[

2.

-
RN

Section - A

Explain the characteristics features of a computer-

" Describe computers on the basis of memory capacity

Define computer. State its advantages and limitations.

Section - B
What is a Digital computer? How it differs from an Analog computer?
List out the different types of computers.

Explain characteristics and special features of the generation of computes.

1.11 FURTHER READING

1. Computer Applications in business — P. Parameswaran- S.Chand & Company

Ltd., New Delhi -110 005.

2. Computer Applications in Business Management —Versha Metha and N.Kumar -

Anmol Publications Pvt.Ltd., New Delht — 110 002.



UNIT 2 COMPUTER SYSTEM

Structure
2.1 Introduction
2.2 Unit Objectives
2.3 Elements of Computer System
2.4 Basic Principles of Operation of a Computer
2.5 Software
2.6 Hardware
2.7 Key Terms
2.8 Summary
2.9 Answers to Check Your Progress
2.10  Questions/Exercises
2.11  Further Reading

2.1 INTRODUCTION

You have studied meaning, classification and uses of computers in Unit No.1. In
this unit you are going to learn the computer system. A computer system is a combination
of various components. It performs the system functions in input, processing, output,
storage and control. Computer system includes Hardware, Software, Humanware,

Firemware and Bridgeware. The following diagram explains the same.

Hardware
Bridgeware — Software
COMPUTER
A SYSTEM ‘
Firmware Humanware

2.2 UNIT OBJECTIVES

After going through this unit, you will be able to
* Listthe various elements of computer system
«  Explain the principles of operation of a computer.
* Differentiate between software and hardware

2.3 ELEMENTS OF COMPUTER SYSTEM

A compute system is a combination of various components. Such as
) Hardware
if) Software

Computer system
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i) Humanware
iv) Firmware
v) Bridgeware
2.3.1 Hardware

The physical components of the computer such as input device, Central Processing
Unit (CPU) and output device are known as Hardware,
2.3.2 Software

Software is the logical and sequential serics of instructions. which arc given to the
computer system on the basis of which it works. Insimple, software is a set of instructions
(i.e. programs) given to the computer system to perform the desired task. There are two
types of software:

1) System software

2) Application software
2.3.3 Humanware

People, who work on the computer, are collectively called Humanware. When
computerisation begins, a team of people has to plan, design and implement the systems
and operate the computers to effectively produce useful results. Throughout the
above-mentioned processes, a number of computer p. >fessionals are needed.
System Manager

He is concerned with planning, monitoring and controlling of all activities related to
computerisation.
Sys‘tem Analyst

He studied the problems to be solved in detail and prepares solution and program
specifications.
Programmer

He prepares computer programs based on the specifications given by the system
analyst,
Data Entry Operator |

He operates the computer system for entering the data.
2.3.4 Firmware

The computer programs permanently stored in ROM (or) PROM are called
Firmware. These programs are provided by computer manufacturing along with the
computers. Generally these are booting programs which help in starting the computer.
Such programs cannot be erased. '
2.3.5 Bridgeware
The computer components and programs used to translate instruction and information
written for one type of computer differ from those of other type of computer. To
understand the components and programs, bridgeware is used. This is necessary when
different c.. nputers are made by different manufactures,




2.4 BASIC PRINCIPLE OF OPERATION OF A COMPUTER

vary in constructional details, the basic principle of operation is almost the same.

Peripherals (input and output devices). It perfcrms the following functions.

2.4.1 Input Unit

reads and accepts the data/programs and then it passes them to the memory unit of CPU.

Some commonly used devices are:

Nowadays, most of the cofnputers being used are digital computers. Though they may
/ computer is a collection of machines such as Central Processing Unit (CPU) an/%

i) Accepting inputs

i) Memory manip.

i) Arithmetic operations
iv) Decision making and
v) Giving output.

We can explain liow these functions are performed by the computers with the help of

ablock diagram.
Arithmetic and
Logic Unit

Inp}lt Main - Output
Unit - Memory Unit

! {

Control
Unit

A computer has cssentially three untis. They are

) Input Unit

i) Output Unit

iy Central Processing Unit (Consisting of memory unit. control unit and arithmetic

and logic unit).

Input device is a device through which data/programs are entered into the computer. It

) Keyboard

i) Mouse

i) Joystick

iv) Magnetic Ink Character Reader (MICR)
v) Optical Character Reader (OCR) .

viy Bar Coding

Computer system
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vii) Magnetic ngs
vil) Magnetic Taves
) Floppy Disks
X) Hard Disks

xi) CD-ROM

xi) Optical Disks
2.4.2 Output Unit

After the data are processed, the output from sych progess may be required in two
formsitmaybeina form readable by the user in a printed form (or) if the information is
required for subsequent processing. It may be necessary to store on, storaga devices. In
certain cases, the user may require the output to be displayed on the screen. Therfore, on
the basic of above requirements, output devices may be classified into three types.

D) Stored Output:
- Magnetic Tape
- Magaetic Disk (Floppy Disk or Hard Disk)
i) Printed Output:
- Printers
- Plotters
i) Displayed Output
- Visual Dlsplay Unit(V DU)
2.3.4 Centrai Processing Unit (CPU)

The central procéssing unit is the nerve centre of the system. It not only performs
the central control function but also it makes all the computational, logical and operational
decisions. It contains Arithmetic and Logic Unit (ALU), control unit and main memory as
its components. In other words, ALU, control unit and memory unit are together called the
Central Processing Unit (CPU). The set of instructions-and data are fed into the computer
by means of an input device. The data and the instractions, thus received thro‘ughicey—
board, are passed into the memory unit. The control unit directs and regulated the informa-
tionrand instructs the:ALU to do the required calculations, by getting data fiom thie memory
unit. After processing, the results are stored in the memory unit. From the memory unit, the
results are displayed by the output unit. | '

On the motherboard, there are some slots through which the various input and
output devices are connected to the microprocessor-and thé memory chips. On the

. motherboard the various components are connected to each other ihrough sets of pa:allei

electrical conducting lines called ‘buses’. The microprocessor itself contains some special
storage locations called ‘registers’. Let us discuss the componegnts of the CPU.

'|i) Arithmetic and Logic Unit

Functionally an ALU can be dividéd into two segments: the ai'&'ﬂfnhéﬁcunit and the
logic unit. The arithmetic yni performs arithmetic dperations such as addition, substracuon,
multlphcatlon etc. The log:c uhit does logical comparisons such as BooltaanAND ORand




NOT. All the operations are carried out on the principle of addition. For example, divis_ionq
is done by repeated additions. In other words, division is nothing but repetitive co'mpleJ
mentary additions.

They are three main components of the ALU: Mathematical gates, logic gates an
registers. A gate is an electroic switch with several entrances but with only one exit. Da
come in through the entrances and answers come out via the exit. A maths gate
performs basic calculations. A logical gate performs logical operations. A register is al
special storage area in the CPU to hold data during the completion of these operations.
Functions / Features of the ALU may be summarised as follows:

i Italways addsin order to perform the various arithmetic operations.

ii) All operations in the ALU are carried out in binary under the control of control
unit. Once the processing is over, the final resuits are released to the output
storage area from there, they procegd toc the output service.

i) ALU which isresponsible for movemet of data between storage and 1tself
performs arithmetic and logical operations.

iv). The movement of data between the ALU and the CPU’s storage area (ic register)
may take place several times before one processing operation is completed.

ii) Control Unit
‘ It controls, supervises and overseas all the activities of a computer and monitors

o

the execution of anyprogram processed. In othef words, the control unit co-ordinates andj
contrq]s the activities of the different components of the computer system. It’s function are
summarised as follows:
1) Itco-ordinates the activitics of the input-output, arithmetic and memory units by
timing and directs the flow of information from one unit to another.
i) Itinterprets each.instruction and directs the other units to perform these
instructions. ’
iii) It supervises input of information, storing and retrieving of information.
iv) It determines sequence of instructions to be executed.
v) It stores the results in the CPU memory.
vi) Itrepeatsthe cycle of operations till either it is instructed to stop (or) the last
instruction is executed. ’
vi) It keeps a watch over the problems such as equipment malfunction, illogical
instructions (or) erroreous-data. °
viii) In order to carryout the various functions (i.e. operations) mentioned above, the
central unit has built certain basic registers: sequénce control register, instruction |
register, decoder, address register, instruction address register. °
iii) Memory Unit
All the instructions and data fed into the computer are stored in this unit. After
performing certain calculations, the results are also stored in the memory. This is also

known as primary storage area, input storage area and output storage area.
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Control ALU
Unit
A —
Main] Memory '
Program ' Working
~ Storage Area | Storage Area
Input Input Storage Output Output
Unit [T Area Storage Area ™ Unit
Program Storage Area : It holds the processing instructions. -
Working Storage Area : It is scratch pad wherein intermediate data are
held while being processed.
Input Storage Area It is the place where data received form the
computer are held until they are processed.
Qutput Storage Area It holds the finished results until released to the

users.
These four areas do not have any physical boundaries. And also they needed not
exist in that order. They can vary from one application to another. The actual size of each

area is determined by the programmer writing the application instructions.

Memory:

The Computer System requires a scratch pad for calculation and a storage area
for keeping its results for further processing. This is called ‘memory’. These are two types
of memoi‘y.

i) Primary memory/Main memory/Intemal memory
iy Secondary memory/Auxillary memory/External memory.
Primary Memory / Main Memory:

Computers are so versatile in the sense that they can deal with a vast amount of
data which remain in the memory. The terms memory and storage are used interchange-
ably in computeronics. The memory, which is built as ailpart of the CPU, is called ‘main
memory’. This is measured according to the amount of data which it can store at a given
time. The storage capacity of the main memory is expressed in terms of bytes.

1 bit (i.e. Binary digit) = Smallest unit of information represented by O or 1.

1 Byte = 8 bits

1 Kilo Byte (i.e. KB) = 1024 bytes

1 Mega Byte (MB) = 1024 Kilo bytes
1 Giga Byte (GB) = 1024 Mega byte
1 Tera Byte (TB) = 1024 Giga bytes.



The Primary Storage is used for Four Purposes:

i) To hold data (in input storage area) until they are processed.

ii) To hold intermediate data until being processed (i.e. in working storage area)

iii) To hold the processing instructions (in program storage area)

iv) To hold the finished results of the processing operations (in output storage area).
Kinds of Memory _

i) ROM (Read Only Memory)

ii) RAM (Random Access Memory)

i) ROM (Read Only Memory)

The main memory can be classified into two types:

i) Magnetic Core Memory and (ii) Semi Conductor Memory

Magnetic Core Memory was introduced in 1955 and was used till 1975. It is con-
structed with millions of basic elements known as “ferrite Cores’. It provides areliable
and fast random access storage. Though it is expensive, it is extremely useful. Here it is
* described only for historical reasons. There is a tendency to call the main memory as
magnetic core memory, event though it is a semi-conductor memory.

All modern computers use semi-conductor memory. Semi-conductor memory con-
sists of electronic circuits prepared on silicon chips. The electronic circuit is called a flip
flop. A flip-flop is also called a storage cell. Thousands of these storage cells can be
prepared on a single silicon chip. Due to this, the size of memory is very small.

i) RAM (Random Access Memory)

Thisis also a part of computer’s memory. It stores all the data and the instructions
and the results obtained fromiits calculation. This is a volatile storage which means that all
the information will be lost when the computer is switched off. The Access time for getting

information is faster one. This memory is otherwise called as temporary memory.

Different between RAM and ROM

RAM
) Itisvolatile in nature

ROM
It is non-volatile in nature
_i)) Information can be stored and Information stored in the memory

retrieved at the choice of the

programimer.

cannot be altered (except in case of
EPROM-Erasable Programmable Read
Only Memory)

i) Itisused to store immediate Permanent Function like Sin x, Cos x-are
results etc. stored.

iv) ltisexpensive It is Cheap

v) Itiseasy tochange [t is expensive to change.

2.5SOFTWARE

Software is a very widely and loosely used term to refer to various packages. In

essence, any program written in any language that will work on a particular computer
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CHECK YOUR PROGRESS
Fill in the blanks

1. The physical components of
a computer are known as

2. People who work on the
computer are called as

Say True or False
3. Software is a set of
instructions.
4. Hard distk is an input unit.
Choose the best.
5.RAM is
a. Volatile in nature
b. non-volatile in nature
C. permanent memory
d. none of the above

system can be classified as software. Thus, the software is the logical and sequential
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series of instructioné, which are given to the computer system on the basis of which it
works. In simple words, software is a set of instructions (programs) given to the computer
system to perform the desired task. The computer cannot beto anything without software.
It acts as an interface between the user and the computer.
2.5.1 Need for Software
In your day to day life, you have to maintain massive records for various purposes.
For making decisions instantaneoulsy on the basis of information, you have to store data
and information. With computer, we can make wonders in any field. You can store large
amount of data and retrieve such data as and when you need for quick decision (or) for
reference. Today computer has become a boon to the human society in all respects. For
example, let us take the case of using computers in railway stations. The manual method of
making reservation has now changed to computerised method. We can make advance
reservations from any place for our onward and return journeys. The place at which reser-
vation is made may differ from the place where we actually start our journey. It was not
possible under manual method of reservations. In banks, trial balance, profit and loss
account and balance sheet are prepared on daily basis with the help of computerised
software. In short, software can be used in any area because of the following advantages.
i) Assofiware are user friendly, we can work conveniently.
i)y Data can be fed into the computers on daily basis through online/off-line methods.
i) Data can be retrieved in any combination at any point of time.
iv) Optimum utilisation of human resources can be made.
By usng computers, man power is considerably reduced. Such human resources
can be utilised for some other jobs.
2.5.2 Types of Software
1) System Software
2) Application Software
1) System Software
System software is a set of instructions designed to opérate and control the com-
puter system. It is generally prepared by the manufacturers of computers. It can be further
classified as follows:
i) Operating System
i) Tranlators
i) Utility programs
i) Operating System
Operating system software is a software which consists of programs that manage

tand control the over all operations of a computer. Computers cannot run without an oper-

ating system. It acts as an interface between the user and the computer. Whenever the
computer is switched on, the operating system is first loaded. Then, only, we can operate
the computer. It performs three functions.




a) System Management
It manages the hardware, software and data resources of the computer systemJ
during the execution of application programs.
b) System Support
It supports the operations and management of a computer system by providing al
variety of facilities.
¢) System Development )

It helps the users to develop system program. For example language translators,
programming tools etc. |

Sinte the operating system functions in the most efficient manner, it maximises the
productivity of a computer system. At the same time, it minimises the amount of Humqn
interaction required during processing. It also helps to enter data, save and retrieve files,
print (or) display output. Of all, it acts an interface between the user and the computer.

In simple terms, the OS performs the following functions:

1) To control input/output operations
1) To take input from the keyboard
i) To display message on the screen
v) To/store data on external storage device
v) To send output data to the printer
vi) To control the printer
There are three types of user interfaces
1) Command drives
i) Menudrives
i) Graphical User Interfaces (GUI)

Present day operating systems have moved towards the graphical user interfaces.
A GUI presents icons, bars, buttons, boxes and other images.

The following are some of the popular operating systems
a) DOS
b) UNIX
¢) Windows and
d) Network
a) DOS

The Disk Operating System (DOS) is the most popular operating system used in|
personal computers. If a computer has more than one user terminal, DOS cannot be used:
In computer terms, we say that DOS is not a multiuser.

In personal computers. MS-DOS (Microseft Operating Systems) and OS/2 (Op-
erating System-2) are generally used.
b) UNIX

Unix is the most popular multi user operating system. In the computers that have]
wore than one user terminal, UNIX can be used.
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¢) Windows

Software, almost all the softwares are now developed on windows based mannet.
In this method, the user has a little work on the keyboard. The monitor shows everything
in the form of pictufes and one can easily choose from the options given. A hardware
called mouse is used to operate the computer. The latest version of windows is
WINDOWS NT and it has been developed by the microsoft company. It is far superior to
UNIX, WINDOWS 95 and it is an advanced OS processing.

- Special features of the GUL, Multitasking, Networking, Multimedia and Several

other capabilities are contained in the windows based OS.

WINDOWS NT (New Technology was introduced in 1993. It is a powerful
multitasking. It is a multiuser OS installed in the Network server to manage LANs and
Workstations.

d) Network
Inrecent developments many computers can be linked together witha master

computer (i.e. file server) Data and programs can be transferred from one computer to
another. For example, the computers in the various departments of the company can be
linked to the head office. This type of connection is called Network. When the computers
are connected with the file server using a netwrok, they neéd an operating system to
handle the network faetlity.
ii) Translators

Computers knows only machine language i.e., binary codes such as 0 and 1.
Therefore, any instructions to the computer must be expressed in machine language. Itis
very difficult to write instructions in machine language. We write instructions in high level
language (which is similar to English statements). Therefore, instructions in high level
language have to be translated into machine language codes.

Translators are of three types:
) Assemblers '
i) Compilers
i) Interpreters
Softwares developed for th1s purpose are categorised as system software.

iii) Utility Programs
Utility programs are system programs which provide facilities for performing some
common tasks of a routine nature. They are: ‘
*  Sortutilities
*  Editors
*  File copying
* File Maintenance
*  Debuggng
*  System status utilities




2. Application Software

Application Software is a software which is written for a specific application. In other
words, it is a set of programs meant for a specific application. For example, programs for
the preparation of Pay roll, programs for inventory control etc. are some of the application
software. Application packages such as dbase, wordstar, lotus 1-2-3, clipper etc, can|
also be terms as application softwares. The following are various application areas of

softwares. _
Accounting Cashbook, bankbook, vouchers, debit and credit notes,
ledger posting, trial balances and balance sheet.
Inventory Information details on stock in and stock out, ordering

level, recording level, other control methods, stock
location etc.

Sales System Price Information, quotation, billing, receipts, cheque

transactions etc.

Purchases All purchase activities, suppliers list etc.

Library System Books purchased, books issued, books returned,
accession register, missing list etc.

Banking Inter-branch transactions, interbank exchange systém,
ATM, ALPM etc.

Transport Ratlways, airlines, ticketing system etc.

2.6 HARDWARE

The electronic circuits and mechanical components of a computer such as
motherboard, hard disk, printers, central processing unit, keyboard, mouse and othe£
peripheral devices, which are tangible in nature, or which can be felt, touched are knowri
as hardware.

Difference between Hardware and Software :

Hardware Software

1) Itisthe physical components Itis a set of instructions to bring the
of the computer hardware system into operatiot:.

ii) The Design can be modified This should be prepared according to
according to.the capacity. the type of the capacity.

iif) Itunderstands only machine Itis written in high level language.
language (or) Low Level Language

iv) It works with binary codes i.e. Itisrepresented by the high level language]
Os and 1s.

v) Itconsists of input unit, output Itis categorised as operating system,
unit and CPU. utility programs, processors application

programs etc.
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| CHECK YOUR PROGRESS

Fill in the blanks
| System software is to
operate and control the

2. Software is written in
level

language.

Say True or false

3. Unix is an operating system
4. Mouse is a software
Choose the best.

Transaltor refers to

a. Assembler

b. Complier

c. Interpreter

b d. all the above.
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2.7 KEY TERMS

« ROM - Read only method

« RAM - Random Access Memory

* System Software - The software which controls the computer and
runs applications.

e Application software - Software that is designed for the solution of an

; application problem.

e Window - A rectangular area of the display screen with
visible boudnaries within which data is displayed.

e Network - A series of inter connected computer terminals
providing a data communication service.

e Assembler - A programme that can accept an assembly
language programme at its input and translate it
into machine code as its output.

e Compiler - A programme that translate a source programe
into an executale programme.

< Interpreter - A programme that analyse each line of ahigh level
language programme and then excecutes it
immediately.

«  Utility programme - A programme that proyides a useful function.

2.8 SUMMARY

A computer is a combination of various components such as Hardware, Software,
Humanware, Firmware and Bridgeware. Computer performs through three essential units
known as Input unit, Output unit and Central Processing Unit. Mouse, Floppy disks, Hard
disks. Key board are some of the important input devices. The output is displayed either
on the screen or in a printed form. The Central Processing Unit which is the nerve centre of
the system consists of arithmetic and logic unit, control unit and memory unit. There are
two types of memory viz., primary and secondary. They are also known as main and
auxilillary memories. Software is a set of instructions given to the comptuer system to
perform the desired taks. System software and application software are the two of its
types. Software can be classified as operating system, translators and utility programs.
Application softwares are written for specific applications. Hardware refers to all the physical
éomponents of a computer.

2.9 ANSWERS TO CHECK YOUR PROGRESS

1. Hardware 2. Humanware 3.T 4.T 5.(a)
6. Computer 7. High 8.T 9.F 10.(d)
2.10 QUESTIONS/EXERCISES

' Section A
1. Define operating system. Explain its various functions.
2. Explain any four operating systems

3. Compare RAMand ROM



Computer system

What do you understand by primary storage and secondary storage

5. Distinguish between Hardware and Software. _ '
Sector B NOTES

6. Whatare the elements of computer system?
7. Explain how a computer functions with the help of a block diagram.
8. Explain the different types of software.
2.11 FURTHER READING

Fundamental of Computers - V. Rajaram - PHI

Learning Private Limited, New Delhi --110001.
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UNIT 3 MANAGEMENT INFORMATION SYSTEM (MIS)

Structure

3.1 Introduction

32 Unit Objectives

3.3 Meaning and Definition of MIS
3.4 Elements of MIS

3.5 Characteristics of MIS

3.6 Functions of MIS

3.7 Establishment of MIS

3.8 Key Terms

3.9 Summary

3.10  Answers to Check Your Progress
3.11  Questions/Exercises

3.12  Further Reading

3.1 INTRODUCTION -

Information is the life-blood of an organisation particularly in the case of system
approach management. A modern organisation demands new dimensions in modern
management due to accelerating complekities. As such nowadays, a modern organisaﬁon
requires a system to provide information to managers at all levels at a right time and in right
form to make decisions MIS (Management Information Systefn) is an organised method
of providing past-present and projection information relating to internal operations and
external intelligence. It supports planning, control and operational functions of an organisation
by furnishing uniform information in proper time frame to assist the decision making

process.’
3.2 UNIT OBJECTIVES
After going through this unit, you will be able to:
. explain the meaning of MIS
. list of elements of MIS
. list of characterists of MIS
. explain the functions
. able to establish MIS in an organisation.

3.3 MEANING AND DEFINITION OF MIS

3.3.1 What is Management?

Management has been defined in a variety of ways but for our purpose it
comprises the processes or activities that describe what managers do in the operation of

their organisation plan, organize, initiate and control operations. They plan by setting



strategies and goals and selecting the best course of action to achieve the plan. They
organize the tasks necessary for the operational plan, set these tasks up into homogeneous
groups and assign authority delegation. They control the performance of the work by
setting performance and standards and avoiding deviation from standard.

3.3.2 What is Information?

Data must be distinguished from information, and the distinction is clear and
important for our purposes. Data are facts and figures that are not currently being used in
adecision process and usually taken from the historical records that we recorded and field
without imediate intent to retrieve for decision making. An example would be any one of
the supporﬁng documents, ledgers and so on that comprise the source material for profit
and loss statements. Such material would/ only be of historical interest to an external
auditor.

Information consists of data that have been retrieved, processed, or otherwise
used for informative or infereence purposes or as a basis for forecasting or for decision
making,

3.3.3 What is System?

A system can be described simply as a set of elements joined together for a
common objective. A subsystem is part of a larger system with which you are concerned.
All systems are parts of larger systems. For our purpose, the organization is the system
and the parts (divisions, departments, functions, unit etc.) are the subsystems.

334 MIS~Definiti9n:

MIS is defined as the combination of men, machine and procedures for collecting
pertinent information from the internal and external sources of a firm and processing these
information for the purpose of facilitating the process of decision making.

MIS is also defined as an integrated user-machine system for providing
information to support operations, management and decision-making function in an
organisation. The system utilises computer hardware and software, manual procedure and
models for analysis. Information is viewed as a resource much like land, labour and capi-
tal. Itis not a free good. It must be obtained, processed, stored, retrieved, manipulated
and analysed, distributed etc. An organisation with a well-defined information system will
generally have 2 competitive advantage over organisation with poor S)}stems.

34 ELEMENTS OF MIS

L/

The MIS can be sub-divided into four categories, each type of system is designed
to a specific requirements.
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Management Information System - '

b
o ! v

TPS IPS ' DSS . PDS
Transaction Information Decision Programmed
Processing Providing Support  Decision Making
System System System System

i) Transation Processing System:
These systems are designed for processing day to day transactions occuring in
the organization. These systems involves large volume of data and mainly help in the

pperation control area of the company.
ii) Information Providing System:

Attempt is made here to generate information to help decision making activity.
Starting with transaction processing system, summary and exception reports are
produced. Summary reports are tabulation of details by categories. Exception reports
provide information about deviations of actuals from planned and indicate the reasons of

deviations.

|iii) Decision Support System:

This system is for improving the analytical capability of the decision maker.
Attempt is made here to create an interactive model of a real life situation, so that the
decision maker can interrogate the system for generation and evaluation of various

alternatives.
iv) Programmed Decision Making System:

This involves creating systems for programmed decision areas, so that a decision
is made by the system instead of a person. This requires very clear specifications of the

procedure used.

3.5 CHARACTERISTICS OF MIS

The following are the characteristics of MIS
i) MIS is management oriented:
The Designing of MIS takes care of the managers, who meet the information

requirement. The development of the system starts after deciding the management needs
and keeping in view of the overall objectives of the management.

ii) Management directed:

Since MIS requires heavy planning and investment, management is deeply
involved in the design, implementation and maintenance of the system.
iii) Integrated System:

Five Ms-Men, Money, Materials, Machines and Methods are the basic resources
of ménagen{ent information and is reco gnized as an important factor and its effective use



contributes to the success of the management. MIS is the catalyst and nerve centre of an
organisation. It has a number of subsystems. In order to make these subsystems effective,
it becomes necessary that they have to be viewed as an integrated system, so that the
result is balanced. It binds together databases of all subsystems of the business system

and through information interchange, integrates the organisation.
iv) Avoids Redundancy in Data Storage:

Since MIS is an integrated system it avoids unnecessary duplication and

redundancy in data gathering and storage.
v) Common Data Flow:

To achieve the objective of integration and to avoid duplication and redundancy
in data gathering, storage and retrieval, data capturing is usually confined to original sources'
and itis done only once. Common data flow tries to utilize minimum data processingeffort
and strives to minimize the number of output documents and reports. This type of
integration can avoid duplication, simplify operation and produce an effective MIS. But
separate files should be opened which are significant to one applciation with the use of
common data flow.

vi) Heavy Planning Element:

Design and implementation of MIS requires detailed and meticulous planning of
such activiites as acquisition and deployment of hardware, software humanware data
processing operations, information presentation and feedback.

vii) Subsystem Concept:

MIS gives provision for breaking into various subsystems based on the activity as
well as the functions of the organisation, so that effective implementation of each
subsystem is possible at a time.

viii) Common Database:

It acts as a master that holds the functional subsystems together. It achieves this
aim by allowing access to different master files of data to several functional subsystms.
Data requirements for different levels of management also supports the need of more than
one database, unique databases and common database.

ix) Flexibiilty and Ease of Use:
MIS has been designed flexible enough to accommodate new requirments. The

system is easy to operate 5o that not much computer skills are required on the part of the
user to access database for information or for carrying out special analysis of data.

x) Computerisation:
MIS can be computerised because of its nature as a comprehensive system. This

provides speed in creatng and accessing files, accuracy, consistency in data processing,

reduction in clerical work. aveid human errors etc.

Management informaiion
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Check your progress

Fill in the blanks

1. Information is the
of an

organisation.

2. MIS can be subdivided

info categories.

3. MIS is

oriented.

Say True or False

4. The processed data is

known as information.

5. A system is a single

element for a common

objective.




Management information
system (MIS)

NOTES

3.6 FUNCTIONS OF AN MIS

Managfnent Information system is a combination of computers and procedures

for providing information that managers use in making decisions.

Collect Data

Massive amount of information are available to organisations - personnel records,
information about customers, information abuot competitors, sales data, accounting data
and so on. The first function of an MIS is to determine the information needed to make
decisions and to organise it into a database.

A ‘DataBase’ is an integrated collection of data stored in one place for efficient
access and information processing.

Data can be obtained from sources, within and outside the organisation. Gener-
ally, most data collected for an MIS came-from internal sources such as company records
or reports and information compiled by managers themselves. External sources include

trade publication, customers and consultants.

Store and Process Data:

‘ After creation of data, a database must be stored and processed in a form useful
to managers. Data are generally stored on magnetic tape or hard disks when mainframe
computers are used and on hard disks or floppy (soft) disks, yvheri minicomputers are
used. The data can be loaded into computers for easyaccess by the useg.' ’

Present Information to Managers:

After collection of data, storing and processing of data, the next step is to pregent

the information to managers for their use.

3.7 ESTABLISHMENT OF MIS (PLANNI,NG AND DESIGNING)

The process of establshing an MIS involves four stages.
3.7.1 Planning for the MIS
3.7.2 Designing the MIS
. 3.7.3 Implementing tﬂe MIS'
3.7.4 Improving the MIS
3.7.1 Planning fer the MIS:

Thisisan imiaortant stages and is critical for MIS success. Comonly cited fagtors
that make planning for the establishment of an MIS are:

i) Typically long periods of time to acquire MIS related data processing
equipment.

'ii) To integrite-it within the operation of the organisation.

| iii) The difficulty of hiring competent operators of the equ- ment
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iv) The major amount of financial and managerial resources needed to operate the

MIS.

AnMIS plaﬁ is to be worked out and it differes from organisation to organisation.

A checklist of major topics are as shown below:

NOTES

i) Hardware projection (derived from projects)

i) Human resources projection (derived from projects)

ii1) Financial projects by time period.

Further details for each of the above need to be worked out.

This particular plan specifies that if management decides there is not sufficient
potential benefit to be gained by establishing the MIS, given its total costs, the projectsj
should be terminated.

3.7.2 Designing the MIS

Designing the MIS involes strategic decision making. The designing of ah MIS
should begin with an analysis of the types of decsiions, the managers actually make in a
particular organisation. MIS should consist of four steps.

1) Defining various decisions that must be made to run an organisation.

i) Determining the types of management policies that may influence the ways in which
these decisions should be made.

iii) Pinpointing the types of data needed to make these decisions.

iv) Establishing a mechanism for gathering and appropriately processing the data to obtain|
needed information. '

For the purpose of evolving a design of the MIS, a number of design inputs con-
sidered essential. Some of the more important design inputs are: '

1) Results of:
- Enterprise wide information requirement analysis
Information interface requirement analysis
SWOT analysis
System audits
Benchmarking exercises
Forecast exercise
ii) Master Plan of Long-term information systems.
iii) Status reports on existing modules and systems.
iv) Corporate goals are reflected through MIS goals and objectives.
v) Corporate policy guidelines for implementation of MIS.

vi) Review of existing resources and their utilization.
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CHECK YOQUR PROGRESS
Fill in the blanks

6.The design of MIS varies
from to organisation.
7.0nce the MIS is operating,
MIS managers should
continuously strive to

the value.

Say True or False

8. Planning is not important
for MIS success.

9. Designing of MIS involves
strategic decision making

10. The design output should
confirm to the design input
requirements,
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The design of MIS various from organisation to organisation. It would be very
difficult to generalize the design considerations that could be made applicable as empirical
design considerations. But, it is only possible to provide general guidelines which would
be applied to most of the designs. The general guidelines are:

i) Individual modules should have a specified degree of fredom linked with certain
1evel of data discipline to ensure integration with otber modules. It should be possible to
commence implementation of individual module or a group of modules without waitng for
completion of other modules in the MIS.

i) MIS design should provide for hierarchical control over individual modules and
for coordination of interfaces.

iii) Interfaces between different moduels should be clearly mapped in terms of

content, frequency and mode of operation.

iv) The design output should conform to the design input requirements.

v) The design is consistent with the existing tools of information technology.
3.7.3 Implementing the MIS

The third stage in the process of establishing an MIS within an organisation is
implementation - that is, putting the planned and designed MIS into operation or action. In
this stage, the equipment is acquired and integrated into the organisation designated data
are gathered, analysed as planned, and distributed to appropriate managers within the
organisation. And line managers make decisions based on the information they receive
from the MIS. Implementing the MIS is explained. ’

3.7.4 Improving the MIS’

Once the MIS is opefating, MIS managers should continiously strive to maximise
its value.

3 8 KEY TERMS

-Management - Toplevel peopleinan organisation who plan, organise and
control operations to achieve the goal.

s[nformation - Processed data for decision making.

*System - Setofelements fora common objective.

«Planning - Process of deciding what to iae done in the organisation.

*Designing - Strategic decision making

sJmplementing - Putting the plan and design into operation.

3.9 SUMMARY

A modem organisation require asystemto provide information to managers at all
levels to make decisions. Management control the performance of the work by setting
standards and avoxdmg deviation from standard. Information consists of data that have

been processed. Management informat system is an integrated use-machine system for



providng information to support management in decision makmg MIS can be sub-divid

into Transaction Processing System, Information Providing System, Decision Support
System and Programmed Decision Making System. Planning, Designing, Implementing]
and Improving are the four stages of establishing the Management Information System. .

3.10 ANSWERS TO CHECK YOUR PROGRESS

1. Life-blood 2. Four 3. Management 4. T 5.F
_ 6. Organisation 7.Maximise 8. False 9. T 10.T
3.11 QUESTIONS / EXERCISES
Section A

1. Discuss the charaéterisﬁcs of MIS
2. Define MIS. What are its elements?
Section B
3. How will you design MIS in an organisation? Explain

4. Explain the elements and functions of MIS in detail.

3.12 FURTHER READING

1. Management Information System - R.C. Gupta - Tata McGraw
Hall Publishing Company Limited, New Delhi.
2. Management Information System - James Breen - Galgotia Publications,
. New Delhi.

Management information’
system (MIS)
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UNIT4 DATAPROCESSING

Structure
4.1 Introduction
4.2 Unit Objectives
43 Data Vs Information
4.4 Stages in Data Processing
4.5 . Objectives of Data Processing
4.6  Techniques of Data Processing
4.7 Methods of Data Processing
4.8 Data Processing Applications in Business
4.9 Key Terms
4.10 Summary
4.11 Answers to Check Your Progress

4.12 Questions/ Exercises

4.1 INTRODUCTION

Data is the plural of the word datum, which means any collection of facts. Datz
can be considered as the raw material of information. The data may be numerical such as
sales report or non-numerical such as employee’s name. Once the data are converted into
meaningful information, they can be called as information. Conversion of data into meaningful
information is called data processing.

Data processing is viewed as a system that accepts data as input, processes it into
information as output. The following diagram give a detailed version of data processing

cycle.

4.2 UNIT OBJECTIVES

After going through this umt, you will be able to:
» Differentiate between data and information
» Explain the stages in data processing
» List the objectives of data processing
» Explain the Techniques of data processing
+ Listthe method of data processing

» Explain how to apply the data processing in business




4.3 DATAVS INFORMATION

Data . Information
(i) Data are raw facts Informations are finished form of data
(ii) Data are unstructured in nature Informations are structured in nature.

| Gid) Unprocessed representation is ‘data’| Processed repersentation is information
iv) This is the bdsis from which This is the basis from which decision is

information is derived. taken.

Information is generated from the data items after performing a set of processes/
operations. Performing these processes in a specific sequence is known as data processing.
Data processing is a series of actions (or) operations that convert data into usefut
information. Therefore, conversion of data into information is called data pr(;cesing-. Data
processing is mainly associated with business and commercial activities, as they involve

.large amount of data.

4.4 STAGES INVOLVED IN DATA PROCESSING

Data processing is the restriction, manipulating (or) recording of data to attach
value and to increase their usefulness for some specific purpose.

4.4.1 Detérmining data to be Processed :

The first step involved in data processing is to determine what data are required to
generate the required information. Such data are to be taken from source documents
(source documents are those documents which contain basic data regarding particular
aspect of organnisation). This step assumes significance in the sense that the collection of
data should be in tune with the objectives of the sj‘/stem. In other words, this step refers to
collection of necessary data to obtain desired result.

4.4.2 Input of Data:

After the collection of necessary data from the source document, the data should
be inputted into the data processing system. Before that, they would be taken to make the
data acceptable to the data processing system (For example: Computer). Sometimes it
may become necessary to code the data for quick reference. If data are coded, only

codes are to be entered into the designate forms.
4.4.3 Manipulation:

Itinvolves the process of classifying the data. sorting the data and summarising the
data.

a) Classif);ing the Data: Classification of data means orgainsing data into related groups
according to one (or) more characteristics. For example: Employees may be grouped on
the basis of designation etc.

b) Sorting: After data are classified, it is necessary to arrange (or) rearrange the data into
some logical order, so that processing can be carried out conveniently. For example:

Data Processing
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employee records may be arranged/rearvanged in the ascending orderdescending order
alphabetically. This arranging (or) rearranging is catled “sorting: It ensures identification of
data, without loss of time.

¢) Verification of Data: Data are to be verified to ensure accuracy before proceeding for
processing them. ‘

d) Comparing the Data: One set of data may be compared with another set of data for
subsequent action.

¢) Calculation: To create meaningful results, arithmetical calculation has to be performed.

For Example: Calculation of net pay of the employees.

f) Summarising: Data to be of value must be reduced to a meaningfull form. This process
is called ‘Summarising’. For example: How many students have passed and how many
students have got first class, second class and so on.
4.4.4 Output:

~ After the ’aata have been manipulated, the resulis have to be delivered/
communicated to the concerned. The distribution of processed data may be in the formeof

reports, tables (or) a document.
4.4.5 Storage'

Finally the results i.e. Processed data-must be retained for future reference.

Whenever need arises they can be retrieved.

The data processing activities can be summarized in the form of chart as follows:

Datelnput | Processing 1 Information

" (i) Determination of ? Classification of data ‘ Formal

mput data from ! ; presemauon of

| source documents f o o * | output je results

(u) Making datain ' Sorting of data Analysxs of data

" acceptable from 5
' (iii) Feeding data ~ Verfication of data . Storage of output
(i) ] Arlthmetlaﬂ I\/hmpulaUm -
(V) | Sumwmadsing of data i !

&£ OBJECTIVES OF DATA PROCESSING

Tke following are the general objectives of data processing.

1) To handle large volume of data

ii) To provide qualiiative and quantitative information.

1i1) To provide appropriate and timely information.

1v) To store information and retrieve them as and when necessary.

v) To maintain the performance of organisation at 6ptimum level.



4.6 TECHNIQUES OF DATA PROCESSING

These are three techniciues available for processing.

1) Manual Data Processing

ii) Mechanical Data Processing and

iii) Electronic Data Processing.
4.6.1 Manual Data Processing

When processing of data is done by the people, it is known as manpal data
processing. It is still in use in most of the concerns. In this system, the human being collects
data, manipulates them and makes output by himself. This method is applicable when the

amount of data to be processed is small. However, it suffers from certain disadvantages

such as time consuming process, inaccurate to certain extent, delay etc.

4.6.2 Mechanical Data Processing

In mechanical data processing, various machines are used to perform processin/g~
operations such as arithmetic calculations, sorting and summarising of data (electro)
mechanical devices such as calculators, tabulators, are used. It goes with certain advantages

such as specd. accuracy. neatness etc.
4.6.3 Elcctronic Data Processing (EDP)

It involves the use of computers. The computers have become a powerful tool for
data processing because of its capability to store large amount of data, the speed with
which it performs and of its capacity to produce results with high degree of accuracy.
Electronic Data Processing implies data processing by computer.

4.7 METHODS OF DATA PROCESSING

Computer systerh process the data with speed, accuracy and efficiency. However,
its efﬁciencsz depends mainly on the way the computer system is utilized. Central Processing
Unit (CPU) of the cbmputer performs millions of instruction per second, depicting its
speed human beings cannot interact with the computers at such speed. Even though the
human beings feed the data at high typing speed, the CPU has to wait a lot for the data
input thus wasting its time which would be better utilized for processing. Another reasons
that Input/ Output devices are basically mechanical devices. They are slow in data transfer,
thus again wasting the time of CPU. To overcome these two restraints, many innovations
have been made both in hardware and software so that many users can use the computer
simultaneously, using the CPU time properly and profitably.

With the aim to achieve optional efficiency, the following different methods have

been used for data processing.
i) Batch Processing
1i) On-Line Processing

iii) Real Time Processing

T
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iv) Time Sﬁaring
v) Multi Programming
- vi) Multi-Processing
vii) Multitasking
viii) Distributed Processing

ix) Spooling

4.8 DATA PROCESSING APPLICATIONS IN BUSINESS

. The following are some data processing applications undertaken by the commercial
organisation.
1. Process Control

In the production process, a computer is directly connected to some plant to
control and monitor it. Here, the computer receives the data directly from the plant. It
analyse the input data and initiates action to control the on-going process.
2. Accounting

The Data processing system can be used to maintain the accounting records and in
the preparation of final accounts. The general ledger, Accounts Payable, Accounts
Receivable, etc are the examples for the computerised accounting system followed in most
business organisations.
3. Payroll preparation

In personnel department the data processing system is used to record the operations
of the number of employees of different departments in each shifts, leave taken, deductions
such as ESI, PF and finally in the preparation of pay slips.

4. Sales Analysis

The Data processing system is highly useful in sales analysis. The sales manager
can prepare the sales forecast on the basis of past month’s sales reports and sﬁbsequent
future actions can be taken. -

5. Inventory Management

Actually the Data Processing system is a boon to every organisation, in respect of
inventory management. Data processing is used to maintain upto date information about

stock, their costs and to initiate orders when the times are about to be exhausted.

6. Office Automation

The modem offices and business organisations are dependent upon computer based

office automation for their competitiveness and better management.
7. Banking and Insurance

Data processing systems are highly needed in banking sector where the custome
satisfaction is the main criterion. To provide quick and perfect service, data processing



system is used. Automatic Teller Machines are placed in big cities and linked to central
computers. Hence, the delay in processing is completely avoided.
8. Insurance and Stock Broking

Insurance companies and stock broking firms also use thé computerised data
processing systems. Large volume of data have to be processed for the preparation of]
policy statements, interest calc u}étions, renewal notices and in dealing with the securities.

9. Managerial Aid

The Data Processing system is used as a managerial aid in decision making by
solving business problems. It is also very useful in the areas of linear programming, PERT,
CPM etc.

4.9 KEY TERMS

*Data - Numbers, Words, Characters that are entered into a computer system

to be stored and processed for some purpose.

‘sInformation - Processed data.
*Manipulation - Changing data to some useful form.
*Sorting - The process of arranging a set of items into a specified order.

410 SUMMARY

Data Processing is a system that accepts data as input, process it into information
as output. Data refer to any collection of facts. Data may be numerical or non-numericals.
When data are processed, they are converted into meaningful information. The objective
of data processing is mainly to handle large volume of data in such a way to provide
appropriate and timely information. Data are processed by following manual, mechanical
and electronic techniques. On-line processing, time sharing, multi-processing, distributed
processing, real time processing are some of the important methods of data processing.
Commercial organisations apply data processing in accounting, pay roll, sales analysis,
inventory rhanagement, banking, insurance, stock broking and also as managerial aid in
taking decisions.

4.11 ANSWERS TO CHECK YOUR PROGRESS

1. datum 2. related /similar 3.T 4T - 5d
6. small 7. Decision 8. T 9.T 5.F
4.12 QUESTIONS / EXERCISES
Section A
1. Define data processing. How does the term ‘Data’ differ from information?
2. What are the steps involved in data processing?
3. What are the objectives of data processing?
Section B

4. - What are the different methods of data processing?

5. What are business applications of data processing?
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UNIT 5 BASIC LANGUAGE

Structure
5.1 Introduction
52 Unit Objectives
5.3 Elements of Basic
5.4 Hierarchy of Operation
5.5 Structure of a Basic Program
5.6 - Basic Programming Statement
5.7 Looping
5.8 Key Terms
5.9 Summary
5.10  Answers to Check Your Pro gréss
5.11  Questions/Exercises
5.12  Further Reading

S.1INTRODUCTION

The computer being an electronic machine, understands only the electrical circuitary.
The operations of the computer are controlled by instructions. The language used for
issuing instructions is catled as programming language. The user has to leam the programming
language to communicate with the computer. Machine language, assembly language and
high level language are the three languages used to write the programs. Machine language
is difficult to learn and time consuming to write. Assembly language is machine dependent
and knowledge of hardward is required. To overcome these difficulties several high level
languages were developed. The high level language does not require the programmerto
have a detailed knowledge of hardware of the computer. The high level language contain
statements that have much lite English and Maths. BASIC,PASCAL, FORTRAN, COBOL
are examples of high level language.

Basic is a user friendly language. Basic stands for “Beginners all purpose symbolic
instruction code”. It was developed by Prof.John Kemeny and Thomas Kurtz in the year
1964 at Dartmouth College, New Hampshire, U.S.A., Since then, basic has undergone
many modifications and improvement. At present many versions of basic are available.

5.2 UNIT OBJECTIVES

After going through this unit, you will be able to:
» Listthe elements of basic
Explain the structure of basic program
 Listand explain the programming statéments
*  Apply the loops in writing the programs.




53ELEMENTS OF BASIC

Basic language is easy to learn and suitable for conversational programming. Itis
suitable for both scientific and business applications. The following are the important elements
of basic language. |

5.3.1 Character set

5.3.2 Variables

5.3.3 Consiants

5.3.4 Operators

5.3.5 Expressions

5.3.6 Statements |
§.3.1 Character set

When you speak or write any language you first learn its alphabets. Similarly when
you want to use any programming language you must learn its character set. It includes the

following.

i) Alphabets AtoZ =26
it) Numerical 0to9 =10
iii) Special characters +, -, *,/ )

N =L >

- . =16"

()“$

Besides the above, the following are also used 1b, # and? Letters are used only in
capital (upper case) form. Using these characters you can form the statements in basic.
53.2 Variable

A quantity whose value changes during execution of a program is called variable.
Here value means either numeric value (or) string value. Each such value has a specific
storage location in the memory of the computer system where it is stored along with the
name of the variable (given by the programmer). Variable can also called as datanames
(or) identifiers (or) User defined names (or) programmer supplied names.

Types of v?riablés are as follows: |
1. Numeric Variable
2. String (or) Non-numeric variable.

1. Numeric Variable

A quantity whose numeric value changes during the execution of a program is
called Numeric Variable. Numeric Variable is one which takes numeric constants.
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Chegde your progress
Fill“in the blanlf

g I BASIC language is

) to learn
and understand

2. In BASIC letters are
used in

form only

3. A quantity whose
numeric value changes
during the execution of a
program is called

variable.

4. A quantity whose value
does not change during
the execution of a
program is called

5. Operators are

used
to execute opeations in
the computer system.
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Example:
20LETD=10
30 LETE=20

In the above example D and E are numeric variable names, and 10 and 20 are

numeric constants.
Rules to define a numeric variable are as follows:
- a) The first character of numeric variable name should be an alphabet character.

b) Some basic versions allow a numeric variable to be a combination of alphabet
and numbers, subject to a maximum of 31 characters out of which the first character
should be an alphabet.

c) Special characters are not allowed except (-) symbol. It can be used in the

middle portion of the variable name. (e.g.) 30 Gross —Pay = 10000.
2. String (or) Non-Numeric Variable

A quantity whose string value changes during the execution of a program is called
strjng variable. String variable is one which takes string constant. '

Example:
“I0LETD$ =“RAJA”
20 LETE$ = ‘RAHUL’

The above exampie states that D$ and ES$ are string variable names, and “RAJA”
and “RAHUL” are string constants.

Rules to define a string variable are

a. The first character of string variable name should be an alphabet character. A$
symbol should be added as a last character of every siring variable name.

b. Some basic versions allow a string variable to be a combination of alphabets and
numbers subject to a maximum of 31 characters out of which the first character
should be an alphabet.

c. Special characters are not allowed except (-) hyphen.
d. Hyphen (-) symbol can be used in the middle portion of the variable name.
5.3.3. Constant

A quantity whose value does not change during the execution of a program is
called constant. '

Types of constant are:
1. Numeric constant and

2. String constant




1. Numberic Consfant:
a. Itisassigned as value to a numeric variable.
Tt should be either an integer number (or) areal number.

c. A numeric constant can optionally have either a “+’ (or) a -* symbol as its first
character.

d. No other special character and alphabets are allowed in coding a numeric
constant. (eg.5678 is valid. 5,678 is invalid).

It can have a maximum of 6 characters.

£ Ifanumeric constant is too large (more than 6 charp,cters), then it can be
expressed in exponent notation. /

2. String Constant:

It is a sequence of “any characters (all alphabet characters, special characters,
numbers, symbols etc) given within quotes. The maximum number of characters allowed
may vary from system to system.

Valid Examples: “SIVA”, “TVS 50”
Invalid Examples:- Siva, “VC
5.3.4. Operators:

These are symbols used to execute various operations in the computer system.
They are classified as follows viz., (1) Arithmetic operators (2) Relational operators and
(3) Logical operators.
1. Arithmetic operator represents either one of the following symbols viz., +, _,/,
* A ’
2. Relational operator represents either one of the following symbols, viz <,>,

=,<>x <=, >=,

3. Logical operétor represents either one of th/e"following symbols viz. AND, OR,
NOT.

5.3.5. Expression:

In general, an expression is a combination of variables, constants and operator.
There are four types of expressions in BASIC viz.,

1. Arithmetic Expression
2. Relational Expression
3. Loglcal Expression
4. String Expression

1. Arithmetic Expression

It is combination of Numeric Variables, Numeric Constants and Arithmetic
operators. No two arithmetic operators should come together in an arithmetic expression.
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General Format:
<numeric variable / <arithmetic <numeric variable /
numeric constant > operator > numeric constant >
~Valid Examples:
B*Q;,
..’ =
=% TBH+H(-C)MN2
. * . pe’
Invalid Exarhples:
B*-C
2.Relational Expression:

It is a combination of Numeric Variables, Numeric Constants, and relatibnal

operators.
General Format:
<npumeric variable / <numeric variable >
numeric expression > operator > numeric constant / numeric expression>
Valid Examples:
' B>C
B<=C
Invalid Examples:
B?<C
D>+E
3.1.ogical Expression:

When two (or) more relational expressions combined by logical operators, it is
called logical expression. It is a combination of variables, constants, relational operator,

and logical operators.

General Format:
<relational<logical<relational
expression>operator> expression>

Valid Examples:

A>B AND A>C
B<C OR B<D
B NOT >C

Invalid Examples:
CANDORD
Cc> D NOT

C<NOTD



Basic Language

4. String Expression:

When two or more string variables / string constants are combined by using +

symbol is called string expression. No other symbols can be used in string expression. NOTES

General Format:
<string variable / + <string variable /
string constant > string constant >
Valid Examples:
“RAJ’+”KUMAR”
B$ +C$
5.3.6. Statements
Basic programming statements are classified into two categories. They are
I. Non-executable statements
1. Executable statements

Non-executable statements do not give any executable instructions to the computer.
They do not affect the results any way. They do not produce any result. It a statement |

provides any executable instructions to the computer, then it is called in an executable

statement.
. Programming Tatement
Executable statement Non Executable StatenTnt
Assignment statement  Input statement output statement |Termination statment DIM -
)LET i) PRINT 1) STOP REM
' it) LPRINT i) END END
Direct Input Repetitive Input
1) INPUT 1)RESTORE

i) READ... DATA

Control System

l l
Conditional Unconditional

(i) IF.... THEN i) GOTO
(i) [F ... THEN.. ELSE

(iii) ON... GOTO

(iv) FOR ... TO..NEXT

47
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I. Non-executable statements
The following are the important Non-executable command verbs.
a. REM statement
b. DIM statement
c. END statement
a.REM Statement:

" This statement is used to give remarks in the program for the reference of the
programmer and to improve the readability of a program. This is a dummy statement. It is
i gnored by the interpreter (or) compiler. It can be placed ahywhere inaprogram. It can be
extended to another line with start of REM.

Syntax:

<Line number>REMc<user given text>
Example:

10 REM PROGRAM TO FIND INTEREST
b.DIM statement: .

DIM is the short form of DIMENSION. Itis used to allocate the memory locations
in one dimensional as well as multi-dimensional arrays. The general format of DIM statement
is:

Syntgx:

<Line number> DIM <variable name>
Example:

10 DIM A (10), x (20)
¢.END statement

' This statement .is used to indicate the physical and logical end of a program. Opl+}
one End statement is allowed in a program. It should be placed in the last line of evel,
program.

Syntax:
<Line number>END

| Example:

90 END
I1. Executable Statements:
1.Assisgnment Statement: LET Verb

To compute an arithmetic expression, LET Verb is used. The keyword LET_ isnot
compulsory in every computation statement.



Syntax:
<Line Number> LET <variable> = <constant>
Example:
20LETB=10
30 LETNS$ ="RAJ"
2. Input Statement:
In Basic. the following input statements are used.'
a. INPUT Statement
b. READ.......... DALA Statement
¢. RESTORE Statement
a. INPUT Statement:

This statement is used to give input data to computer during program execution.
Whenever an INPUT verb is executed in a program. the computer system displays d

‘question mark (?) on the monitor and waits for the value(s)to be taken for variables.
Syntax:
- Line number> INPUT <string™, <variable(s)>
Example:
I0INPUT “ENTER THE NAME", N§
20 INPUT "ENTER VALUES TOP,N. R™. P.N.R.
b. READ...DATA Statement

In READ verb. list of variables are given. In DATA verb. list of vivos oovo v o

civen REEAD verb instructs the computer system, to read the data trom anot!-c: -« orb

called DAIA verb which supplies the data corresponding to variables inhe RE- A verb.
Syntax:
- Line number> READ <List of Variables>

----------

<Line number> DATA <List of Constants>
Example:

10READA.B.C

30 DATA 10, 15, 20

For every variable in READ verb, corresponding valuc should be given in the
DATA verb. If there is lack uf data then the computer system will give an error message.

The DATA verb may be placed anywhere is a program.
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c. RESTORE Statement:

Some problems require some of the data to e read more than once. To do this you
NOTES must reset the pointer to the start of the data block. The RESTORE verb is used for this

purpose.
Syntax:
<Line number>RESTORE
Example:
10READB,C,D
20 RESTORE
30READE,F
40 DATA 10, 15,20

When the line number 10 is executed, the value for variable B, C, D will be assigned
10. 15, 20 from the DATA verb in line number 40. When the line number 20 is encountered
the pointer reset and hence the value for variable E, F as stated in READ verb in line
number 30, will be assigned 10 and 15 as stated DATA verb in line number 40.

) 3 Control Statements:

Control statements are of two kinds, viz.,
a. Unconditional Control Statement: GOTO verb

Unconditional control statement is used to transfer the control from one place to
another part of the program without any condition. For this purpose, GOTO verb is used
in the BASIC program. GOTO verb transfers the control from oone place to another place
without any condition.
Syntax:

<Line number> GOTO <Line Anumber>

Example: |

10 A=5

20B=7

30B=B+A

50 GOTO 20

60 END
b.Conditional Control Statement or Branching Statement;:

_ Conditional control statement is used to transfer the control from one place to
another part of the program conditionally. For this purpose, the following verbs are used.

i IF..THEN veru
i. IF.THEN. ELSE verb
50 ‘ i ON..GOTO verb




i.IF...THEN verb:

This is a deciston making statement. Ifthe condition given between the keywords
IF and THEN is true, then the statement after THEN will be executed. If the condition is

wrong, the control will skip to the next line.

General syntax:

<Line number> IF <condition> THEN <statements>

The above syntax explain that condition may be either relational condition (or)
logical condition. Statement may be line umber, (or) assignment statement, (or) computation
statement, (or) INPUT verb, (or) PRINT verb

Any one of the following syntax can be used according to the circumstances.
Syntax —1:

<Line number> IF <condition> THEN <Line number>

This syntax-1 is used to transfer the control to any statement of the program
depending upon a given condition.
Example:

60 IF I <100.THEN 30
Syntax-2:

<Line number> IF <condition> THEN <Assignment verb>

This syntax-2 is used to assign a value to a variable upon a given condition.
Example:

60 IF A>B THEN A=100
Syntax-3:

<Line number> IF <condition> THEN <Computation verb>

This syntax-3 is used to compute an arithmetic expression and assign the result of
the same expression to a variable upon a given condition.

Example:
60 IF B>C THEN B=100
Syntax-4:
<Line number> IF <condition> THEN <INPUT verb>
This syntax-4 is used to get input data upon a given .condition
Example:
80 IF A>B THEN INPUT C
Syntax-5:
<Line number> IF <condition> THEN <PRINT verb?
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This syntax-5 is used to display the output in the monitor upon a given condition.
Example:

90 IF A>B THEN PRINT “A IS BIGGER THEN B”
ii.IF..THEN...ELSE Statement:

This is a decision making statement. If the condition given between the keywords
IF and THEN is true, then the statement between THEN and ELSE will be executed. If
the condition is wrong, then the statement shown after ELSE will be exccute.

<Line number> IF <condition> THEN <statement 1> ELSE <statemcnt 2)

In the above syntax, condition may be either relational condition (or) logical
condition. Statement may be line number, (or) assignment statement, (or) computation
statement, (or) INPUT verb, (or) PRINT verb.

Example:

10 IF A>B THEN PRINT-“A IS BIGGER” ELSE PRINT “B IS BIGGER”
iii.ON...GOTO Statement: (Branching Statement)

ON...GOTO verb is used for multiple branching. It is used to transfer the control

according to the value of a variable (or) expression.
Syntax:

<Line number> ON <variable/expression> GOTO <LIST OF LINE NUMBERS>
Examples:

10INPUTB

20 ON B GOTO 30, 40, 50

30 PRINT “ONE”

40 PRINT “TWO”

50 END

4.0UTPUT Statement:
PRINT Verb:

PRINT verb is used to display the result on the screen,
Syntax:

<Line number> PRINT <Constants>, <Variables>
Examples:

20 PRINT “NAME”, N§

The following are the various torms of PRINT verb.
a. Print with Semicolon Option:

If the list of variables in the print verb are separated by semicolon, the values of the
variables will be printed in a closed fashion.



<Line number> PRINT <LIST OF VARIABLES SEPARATED BY
SEMICOLON>

Example:
100A=10
20B =20
30C=30
40 PRINTA; B; C
50 END
If the you run the above program then output is like as follows.
10 20 30

b.Print with comma option:
It the list of variables in the PRINT verb are separated by comma, the values of

the variable will be printed in each zone consisting of 15 columns.
Syntax:
<Line number> PRINT <List of variables separated by comma>
Example:
10B=20
20C=40
30 D =60
40 PRINTB,.C.D
S0END
If you run the program then the output willbe 20 40 60
c.Print the Message:
The print statement can be used to print the message (or) information in the screen.
The message should be specified within the double quote symbols.
Syntax:
<Line number>PRINT <“MESSAGE">, <Varaible>
Example:
10 PRINT “ALL ARE WELCOME”
20 PRINT “SIMPLE INTEREST”,SI
d.Print with no List:
This print verb is used to create a line space in the screen
Syntax:
<Line number>PRINT
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Example:
20 PRINT “WELCOME"
30 PRINT
40 PRINT
50 PRINT “TO OUR HOME"
Output will be
WELCOME
TO OUR HOME
e.Semincolon or Comma at the end of print verb:

If semicolon at the end of PRINT verb, the printer pointer will not be shifted to the
beginning of the next line. It can be explained by an example.

Example.
16 B =20
20C =40
30D=50
40 Print B;C;
50 Print D
60 End
Output will be
20 40 50

If comma is not placed at the end of Print verb, the printer pointer will be shifted to
the beginning of the next line. It can be explained by an example.

10B =20
20 C =40
30 D =50
40 Print B, C
50 Print C
60 END
Output will be
20 40
| 50
f) Print with Tab functions:

In order to start printing the values from any desired ‘column, BASIC allows a
function, known as TAB function (Tabulation function).




Syntax:
<Line number> PRINT TAB (column number); <variable>

In the above syntax, column number should be an integer (or) an arithmetic expression.For

each variable, a TAB function is to be given and separated by semicolon.
Example:

10CI =1000

20 PRINT TAB (10); “COMPOUND INTEREST”, TAB (20),;CI
Output:

The word COMPOUND INTEREST will be printed on the 10" column and the
value of CI (i.e., 1000) will be printed on the 20" column.

g) Print using verb:
This verb is used to format the output.
Syntax:
<Line number> PRINT USING <“FORMAT CODE">; <Variable>
In the above syntax, format code may be any one of the following,.
# (hash)-for numeric digits with rounded
* (period) - for decimal point
* (asterik) - to fill left most digits with *
Example:
10 B =5252.4954
20 PRINT USING “#### ##”, B
30 N = 10000
40 PRINT USING “**”; N
50 END
Output will be
5252.50
**1 0600
5) Termination statement:

a) STOP statment. This statement terminates the pfogress temporaily. The program
can be resumed by using “CONT” Command. There may be more than one STOP
statements in a program.

The general format of STOP statement is syntax <Line No> stop
End statement ,

The End statment is the last statment in a program. It indicates that the program is
completed. It terminates the program permanently.

Basic Language

NOTES

55



Basic Language

NOTES

56°

The general format is:
Syntax:
<LE{E NO> END
There should be only one END statement in a program.
5.7. LOOPING

Looping refers to the repeated use of one (or) more steps.

Types of Loops:

(1) Fixed Loops

(2) Variable Loops
() Fixed Loops:

It is one where operations/processing steps are repeated at a fixed number of
times. Fixed loops can be executed by the following verbs.

(i) FOR......NEXT Loop |
(i) IF...... THEN Loop and
(iii) WHILE......... WEND Loop
(i) FOR.......NEXT Loop:

This verb is used to execute a set of statements with in the For...... Next Loops for
a specified number of times.

Syntax: <Line number> For i=n1 to n2 step n3
<Line number> <statement 1>
<Line number> <statement 2>
<Line number> <statement n>
<Line number>NEXT 1
I represents a running numeric variable
nl represents the initial value for the numeric value .
n2 represents the final value for the numeric value .
n3 represents either incrementél (or) decremental vlaue of the numeric value i.
Example:
10 FOR I=1 TO 5
20 PRINT “THANK YOU”
30NEXT1
40 END



The above program executes the line number 20 and print the word “Thank You”

for 5 timss in the screen.
(ii) IF........... THEN Loop:
This verb is used to execute a set of instructions for a specified number of times.
Syntax:
<Line number> <Condition>THEN<LINE NUMBER>
Example: 101=1
20 PRINT “WELCOME TO OUR HOME”
30I=1+1
40IFI1<=10 THEN 20
50 END-

In the above example, line numbers 20 and 30 will be repeatedly executed until

the condition I<10 becomes false.
(iii) WHILE............. WEND Loop:

This verb is used to execute a set of statments with the while........ wend loop for

a specified number of times.
Syntax:
<Line number> WHILE <Condition>
Statement 1
Statement 2
Statement n
<Line number> WEND

Inthe above syntax, statements 1,2,................ n, will be repeatedly executed, when
the given condition after the keyword WHILE has a true value. When the value of the
condition is false, the control will be shifted to the next statement after WEND statement.
Here the condition may be either relational condition (or) logical condition.

Example: 101=1
20 WHILEI<=10
30PRINT “WELCOME TOALL”
40I=1+1
50 WEND
60 END
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logical operators, it 1s
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expression.

7. DIM is the short
form of

8. GOTO statement is
an control
statment.

9. END statement
terminates the program

10. The repeated use of
one or more steps is
known as
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Output of the above program will repeatedly print the word “WELCOME TO
ALL” for 10 times until the condition shown in the while verb becomes false.

b) Variable Loop:

Variable loop is one where the operations are repeated until a specified condition
is met. Here the number of times i.e., loop may vary in accordance with the satisfaction of

the given condition.
Syntax:
<Line number> IF <Condition> THEN <Line number>
| 10 OPT="YES”
20 INPUT “ENTER YOUR OPTION YES ORNO”, OPT §
30 IF OPT$ =“YES” THEN 50
40 GOTO 20
50 PRINT “YOU ARE ADMITTED”
60 END

Example:

In the above example, the control will be repeatedly transferred from line number
40 to line number 20 if the condition in line number 30 becomes false. Line number 50 will
be executed and program will be ended when the condition in line number 30 becomes
true. So that the repeated action may vary in accordance with given condition in line number
30 becomes true. So that the repeated action may vary in accordance with given condition
intheIF ............. THEN verb.

Nested Loop:

One loop can be tested with another, if desired. Nested loop can be created by

ziny one of the following loop.
a) Nested For Loop.
b) Nested If Loop.
a) Nested FOR Loop:

One (or) more FOR LOOP can be included within the scope of another FOR

LOOP. This 1s called Nested For Loop.
Syntax: . 10 FORI=n1 TOn2 STEP n3

-------------

.............

70NEXT]J -
8O0NEXTI



In the above syntax

nl refers to the initial value of 1.

n2 refers to the final value of L.

n3 refers to the incremental (or) decremental value of 1.

ml refers to the iﬁitial value of J.

m?2 refers to the final value of J.

m3 refers to the incremental (or) decremental value of J.
Rules of Next For Loop are as follows:

i) Each nested loop must begin with its own FOR statement and end with its own
NEXT statement.

® Anouter loop and inner nested loop cannot have the same running variable.
i) The Loops cannot be overlapped.

(iv) Control can be transferred from an inner loop to an outer loop.

W) Control cannot be transferred from an inner loop to the outside the outer loop.
b) Nested IF Loop:

One (or) more IF statements can be included within the scope of another IF
statenrent. This is called Nested If Loop.

Example: 10 I =1
20J =1
30 PRINT “WELCOME
40J=J+1
SO0IF J <=2 THEN 30
60I=1+1
70 IF I1<=3 THEN 20
80 END.

In the above example, line number 30 will be executed for 6 times by the execution
of Nested IF in line numbers 50 and 70.

S8 KEY TERMS

+ Character Any letter. number or symbol produced on key board for
display ona VDU

+ Constant A value or an ite’m of data that is fixed and cannot change
‘or be changed.

* Variable A Quantity that can take an any of a set of values

* Operator : A symbol representing the operation to be performed
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« Expression

’ Statc;ment

A representation (arithmetic logical, relational etc) of a
value

The basic building block of a programming language. It
represents a step in a sequence of instruction.

e String A sequence of letters, digits, characters or otner elements
of the same nature

* Loop Aninstruction which is executed repeatedly for a specified
number of times.

5.9 SUMMARY

BASIC is a user friendly high level language. it is easy to learn and simple to
understand. For wirting BASIC programs you have to use only upper case letter. Duri £gn
teh execution of the program when the value of a quanitity changes, it is called variable and
when it does not change itisknown as constant operators are the symbols. EXp;ression is
a combination of variables, constatns and operators. The expressions are of f1 types viz..
Arithmetic, Relational Logical and string. Executable statments give instructions to the
computers. Non executable statments viz REM, DIM and END do not give any exccutabic

instructions. Looping is used to execute a sot of statments repeatedly. Fixed loopx are

.| used to execute a sot of statments for a specified number of times whereas the vanabic

loops are repeated until a specified condition is met with.

5.10 ANSWERS TO CHECK YOUR PROGRESS

1) Easy 2) Upper case 3) Variable, 4) Constants M Svnbols ’

6) logical 7)Dimension 8)Unconditional 9) permancntly oo

5.11 QUESTIONS/EXERCISES

Section - A
1. What is constant? Explain its types in BASIC
2.Explain FOR..... NEXT statment with an example.
3. Explain different types of INPUT statments in BASIC
4. Define variable. Explain its types.
5. Discuss the different form of PRINT statment in BASIC
Section - B
6. Write a BASIC program of find the following SUM = 1+3+5+7+......... £ Q9
7. Write a BASIC program to find the smallest number among N numbers.

8. Describe the different types of Loop statments in BASIC with example.
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5.12 FURTHER READING

1. Computer Programming in Basic - E. Balagurusamy - PHI Learning NOTES
Private Ltd, New Delhi 110 001.

2. Computer Programming in Basic - S. Velayuthampillai - Emerald, Chennai.
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UNIT 6 PROGRAMS IN BASIC

STRUCTURE
6. 1 Introduction
6.2 Unit Objectives
6.3 Example Programs in Basic
6.4 Questions/Exercises
6.1 INTRODUCTION

In unit 6, you have studied the BASIC language. You have also studied the BASIC
statements and learned about looping. After studying the theoritical aspects of the BASIC

language, one should apply the same in writing the programmes. In this unit, examples in
BASIC programmes have been discussed. Model questions are given to improve your
understanding in BASIC programiming.

6.2 UNIT OBJECTIVES
After going through this unit, you will be able to:

. Explain the procedure in writing BASIC programmes.
. Write programmes in BASIC language.
6.3 EXAMPLE PROGRAMS IN BASIC

Write a Basic Program to

1. Calculate Simple Interest and Compound Interest from the given INPUT values
for Principal amount, Number of Years and Rate of interest:

10 REM TO FIND SI & CI
20 INPUT “ENTER THE PRINCIPLE AMOUNT”, P
30 INPUT “ENTER THE NUMBER OF YEARS”, N
40 INPUT “ENTER THE RATE OF INTEREST”, R’
S0 LET SI=P*N*R/100
60 LET CI=P*(1+R/100)"N-P
70 PRINT “SIMPLE INTEREST IS, SI
80 PRINT “COMPOUND INTEREST IS”, CI
90 END
2. Find the selling price of a commodity whose cost price and protit percentage are
given:
Formuia: Selling Price = Cost Price x (100 + Profit Percentage/100)
10 INPUT “COST PRICE AND PROFIT PERCENTAGE”, C,P
20 S = C* ((100+P)/100)




30 PRINT “SELLING PRICE”, S

40 END

Find the cost price of a commodity whose selling price and profit percentage are
given:

Formula : Cost price = Selling Price / ((100+Profit Percentage)/100)
10 INPUT “SELLING PRICE AND PROFIT PERCENTAGE”, S,P
20 C =S /((100+P)/100)

30 PRINT “COST PRICE”, C

40 END

Find the average of given 5 different numbers:
I0READA,B,C,D,E

20 LETAVE = (A+B+C+D+E)/5

30 PRINT “AVERAGE”, AVE

40 DATA 23, 24, 45, 64, 69

50 END

Find the average marks in a subject for N number of students:
10 INPUT “ENTER N DIFFERENT NUMBERS”, N
20S=0

30FORI=1TON

40 INPUT “ENTER THE MARK”, M

50 S=S+M

60 NEXTI

70 AVE =S/N

30 PRINT “THE AVERAGE MARKS ARE:”, AVE

90 END

Find the biggest number among three different numbers:

10 INPUT “ENTER THE VALUES FORA,B,C,”A,B, C
20IF (A>B)AND (A>C) THEN BIG =A

30 IF (B>A) AND (B>C) THEN BIG =B

4C IF (C>A) AND (C>B) THEN BIG = C

50 PRINT “THE BIGGEST NUMBER IS”, BIG

60 END
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10.

~ 40 INPUT “ENTER THE SUBSEQUENT NUMBER”, M
- 50 IF M<SMALL THEN SMALL =M

Find the biggest number among three different numbers using IF..... THEN... ELSE
verb: :

10 INPUT “ENTER THE VALUES FOR A, B.C”, A, B, C
20 IF A>B THEN BIG = AELSE BIG =B

30 IF B>C THEN BIG =B ELSE BIG =C

40 PRINT “THE BIGGEST NUMBER IS”, BIG

50 END

Find the biggest number among N different numbers:

10 INPUT “ENTER THE VALUE FORN:”, N

20BIG=0

30FORI=1TON

40 INPUT “ENTER ANUMBER FOR M:”, M

50 IF M>BIG THEN BIG =M

60 NEXT1I ;

§
70 PRINT “THE BIGGEST NUMBER AMUNG N DIFFERENT NUMBER
IS”, BIG

80 END

. Find the smallest number among N different numbers:

10 INPUT “ENTER N DIFFERENT NUMBERS”, N
20 INPUT “ENTER THE FIRST NUMBER”, SMALL
30 FOR I =1 TO N-1

i

60 NEXTI

70 PRINT “THE SMALLEST NUMBER AMONG N DIFFEREN'T
NUMBERS”, M '

80 END

Find the sum of natural numbers upto given N value. Using IF verb:
10 INPUT “ENTER THE VALUE FORN”, N

20S =0

301I=1

40 S =S+1

50I=1+1

60 IF I<=N THEN 40



11.

13.

14.

70 PRINT “SUM OF NATURAL NUMBER:”, S

80 END

Find the sum of natural numbers upto given N value, Using FOR .... NEXT verb:
10 INPUT “ENTER THE VALUE FORN”, N

20S8S=0

30FORI1=1 TON

40 S=S+1

SO0NEXTI

60 PRINT “SUM OF NATURAL NUMBER”, S

70 END

Find the sum of odd number upto given N value. Using IF verb:
10 INPUT “ENTER THE VALUE FORN”, N

20S=0

50I=1

40 S = S+1

50I=1+2

60 IF 1<=N THEN 40

70 PRINT “SUM OF ODD NUMBER:", S

80 END

Find the sum of odd numbers upto given N value: Using FOR....NEXT verb:
10 INPUT “ENTER THE VALUE FORN”,N -

20S=0

30 FORI=1TON STEP 2

40 S =S+1

S0 NEXT1

60 PRINT “SUM OF ODD NUMBER?”, S

70 END

Find the sum of even numbers upto given N value. Using IF verb:
10 INPUT “ENTER THE VALUE FORN”, N

20S=0

301=2

40 S =S+1"

501 =1+2

60 IF I<=N THEN 40
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70 PRINT “SUM OF EVEN NUMBER:”, S
80 END _ _
15. . Find the sum of even numbers upto given N value. Using FOR...NEXT verb:
i 0 INPUT “ENTER THE VALUE FORN”,N
208S=0
30 FORI=2TON STEP 2
40 S =S+1
S0 NEXT1
60 PRINT “SUM OF EVEN NUMBER?”, S
70 END
16.  Find the sum of factorial numbers upto given N value. Using IF verb:
10 INPUT “ENTER THE VALUE FOR N7, N
20S=1 |
30I=1
40 S = S*]
501=I+1
60 IF I<=N THEN 40
70 PRINT “SUM OF FACTORIALNUMBER:”; 8
80 END
17. Find the sum of factorial numbers upto given N value: Using FOR... NEXT verb:
10 INPUT “ENTER THE VALUE FORN”, N
20S=1
30FORI=1TON
40 S = S*1-
50 NEXT1
_ 60 PRINT “SUM OF FACT-NUMBER?”, §
70 END
18. Find whether the given number is prime or not:
10 INPUT “ENTER ANUMBER”, N
20C=90
30 FORI1I=2TO N-1
40 IF N MOD I =0 THEN C = C+1
 S0NEXTI |
66 . 60IF C=0 THEN PRINT “THE GIVEN NUMBER IS PRIME”. ELSE PRINT

NOTES




19.

20.

21.

22.

“THE GIVEN NUMBER IS NOTPRIME”
70END
Find the sum of digits for a given number:
10 INPUT “ENTER ANUMBER AS STRING”, N§$
208=0
30 FORI=1 TO LEN(N$)
40 S =8 + VAL (MID$(NS, 1, 1) *3

SONEXT I

60 PRINT “SUM OF DIGITS”S TO END=S THEN PRINT “GIVEN NUMBER
IS ARMSTRONG”
ELSE PRINT “GIVEN NUMBER
IS NOT ARMSTRONG”

70 END

Find whether the given number is armstrong or not:

10 INPUT “ENTER ANUMBER AS STRING”,N

20 S=0

30 FORI=1 TO LEN (N$)

40 S=S+VAL (MID $ (N$, 1, 1) "3

S0NEXTI -

Find whether the given year is leap or not:

10INPUT “ENTER THE YEAR”, Y

20 IF (Y MOD 4 = 0) AND'(Y MOD 100<>0) OR (Y MOD 400=0) THEN
30 PRINT “THE GIVEN YEARISNOTLEAPYEAR”

40 GOTO 60

SOPRINT “THE GIVEN YEAR ISALEAP YEAR”

60 END

M/s. VIVEK FINANCE CO. has the following interest rate for a deposit scheme:
Less than Rs.1000 10%

Between Rs:1000 and Rs.1999 11%

Between Rs.2000 and Rs.2999. 12%

Between Rs.3000 and Rs.3999 13%

ABOVERs.4000 14%

Write a program to find the maturity amount, (given year as ‘N”) using the formuld
A=P(1+R/100)", with the help of ON ..... GOTO statement.
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10 INPUT “ENTER THE PRINCIPAL AMOUNT AND NUMBER OF
YEARS”,PN

20 ON (P/1000+1) GOTO 30, 40, 50, 60, 70
30R=10:GOTO

40R=11:GOTO

50R =12 : GOTO

60 R=13: GOTO

70R=14:GOTO

80 A = P*(1+R/100)"N

90 PRINT “MATURITY AMOUNT FOR”: P; “=RS.”;A
100 END

23. Printagiveh multiplication table:

10 INPUT “ENTER A MULTIPLICATION TABLE NUMBER”, M
20 FORI=1TO 10

30S=1*M

40 PRINT[; “*”; M; “="; S

50 NEXT1

60 END

6.4 QUESTION/EXCERCISES

Section-A
1. Write a program to print all even numbers between 1 and 20
2. Write a Basic Program to find the smallest number among N numbers.
3. Write a program to sum the squares of even number between 1 and 20.
4. Write a program to find the sum of N given numbers.
5. Write a Program to find the mean of given 10 numbers.
Section - B
6. Write a program to find the sum of N given numbers.
7. Write a program to add two given matrix. '
"8. Write a program to arrange the numbers in Alphabetical order.




UNIT -7SPREAD SHEET

Structure
7.1+ Introduction
7.2 Unif Objectives
7.3 Advantages of Spread sheets
7.4 Spread sheet screen
7.5 Entering Data in a Spread sheet
7.6 Editing cells
7.7 Saving the work sheet
7.8 Key Terms
7.9 Summary
7.10 Answers to check you progréss.
7.11  Questions/Exercises
7.12  Further Reading
ZL1INTRODUCTION

Spreadsheet is an electronic worksheet. It is used to store information in the memory,
of a computer. The spreadsheet will ask the computer to calculate results and display on|
the computér screen. In other words, it replaces the normal paper sheet, pencil, eraser
and calculator. In such a worksheet, information is entered through the keyboard and
displayed on the screen. The information already entered in the worksheet can be cl{anged
very easily. If some information is altered, the worksheet automatically recalculates the
results. The information entered in the worksheet can also be printed.

You can store all kinds of information in the worksheet. Some common applications
- are.- '

- Budgets

- Annual repdrts of business firms

- Income statement and income tax calculations
- Payrolls

- Invoices

- Accounts payable and receivable

- Production and marketing analysis

- Investment and loan analysis

- Banking

- Inventory control

- Cost effect analysis (using IF.... THEN)
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7.2 UNIT OBJECTIVES
After going through this unit, you will be able to
e . Listthe advantéges of spread sheets.

Notes

. Explain the spread sheet screen

. Explain the procedure for entering data

. Learn how to edit cells

. Learn the procedure to save the work sheet. .
7.3 ADVANTAGES OF SPREAD SHEETS

Spreadsheet replaces the normal paper sheet, pencil, eraser and calculator. Using
an electronic spreadsheet offers several advantage over the paper counter-parts. If you
.change a figure, the spreadsheet program automatically recalculate all the formula using
that figure and instantly update the spreadsheet. The electronic spreadsheet generally
offers the following features.

1. Mathematical, trigonometric, financial and statistical functions are build in. Hence
all sorts of complicated calculations can be performed easily using these functions.

The results are accurate.
- The size of the spreadsheet is very big. Any part of it can be viewed or edited.
Data can be viewed in the form of different graphs.
The whole or part of the spreadsheet can be printed.
The spreadsheet can be saved in a file. Hence it can be retrieved.

" One spreadsheet or part of it can be merged with another.

® N 0k W N

Reports can be quickly prepared. Answer to “What - if”” questions can also be
received.

19 Information stored ina spreadsheet can be transferred to another software programs
and vice-versa. .

7.4 SPREAD SHEET SCREEN

~ To get into spreadsheet take the 1-2-3 option from the access screen, the monitor

displays a blank worksheet, similar to one shown in figure.
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The screen comprises of READY symbol at the right hand top corner of the
spreadsheet. Date and Time are displayed at the bottom left corner. The spreadsheet is a
matrix of cells. The rows are numbered in order from 1 and constitute 8192 rows and|.
columns fromAtoZ, AA,AB .... and so-on, to a total 256. The screen can accommodate
only 20 rows and 8 columns due to size limitations. The screen is divided into three parts.

1. The Control Panel
2. Tﬁe Spreadsheet (worksheet) area.
3. The Status Line.

1. The Control panel:

The top three rows are called the control panel. The information displayed on the
control panel is useful when you are working on 1-2-3. The control panel displays
informations suchas.

)] The eddress and contents of the current cell.

i) The information being entered in the current cell.
1ii) The menu.

iv) Prompt message.

V) The status of the Spread Sl}eet through the mode indicator.
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1. The Spread sheet is an
worksheet.
2. The top three rows of
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as the

E. The last line on the

creen is called the

line.

4. A label is a

=ntry.

5. Label entries are
aligned
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2. The Spreadsheet area:

The middle portion of the screen is called the spreadsheet area. Here data are
entered and the calculated results are displayed. The spreadsheetareaisa grid of rows
and columns. It has a highlighted border on the top and left side known as spreadsheet

frame. !
3. The status line::
The last line on the screen is called the status line. The line displays.
i) The current date and time
il) Error message
iil) Status of special keys.
iv)  status of UNDO.
7.5 ENTERING DATAIN ASPREAD SHEET
You can enter any kind of data in a cell by typing. Move the cell pointer to a cell,

{ type the entry and press RETURN. When you press RETURN, 1-2-3 completes the

entry and moves the cell pointer to another cell in the direction of the pointer movement
key. A cell accepts three types of data.

i) Labels

i) Numbers

1if) Formule
i) Entering Labels:

Alabel is a text entry. All kinds of textual information such as the name of a person,
thing, city etc is a label. The maximum length of a label can be 240 characters. A label can
contain number character, as long as the first character is a label-prefix character. When
you enter the first character, the mode indicator changes from READY to LABEL. When
you complete a label entry, the mode indicator changes back to READY. Beginning an
entry with a label-prefix character determines, how the entry is aligned in the cell. There
are three choices for the label - right aligned, centered and left aligned. A label, when

typed, aligns on the left edge of a cell.

As an illustration, let us enter the following data on the spreadsheet.

MARK STATEMENT
SUBJECTS MAXIMUM SCORED
Environment 100 | 65
Accounting 100 60
Banking 100 - 68
Computer 100 75

Total . 400 268




Enter the label “Mark Statement” in the spreadsheet. Since the cell pointe; isin
cell Al, the information is stored in that cell itself. Assoon you are start typing, the
made indicator changes from READY to LABEL. After entering the label, press return

key.” A The computer displays “Mark Statement” in cell A1 and in the first line of the
control panel.

Now move the cursor down using the down arrow key E twice to cell A3. "Enter
“Subject”. Again press E twice to cell AS. Enter “Entertainment”. Again press E once
and the cell pointer is positioned in cell A6. Enter “Accounting” and so on till “computer”.

Now press home key. The key will take the cell pointed to the cell Al. Now
press right arrow key E to move cell B1 and then Press E to move to cell B3. Enter the
label “Maximum”. Similarly move to C3 cell and fill cell C3 with “Scored”. On this you
get the spreadsheet a'shown in figure.

A Worksheet with label and lables entries
A8:computer A READY]

A . B C D E F G H
MARKS STATEMENT

SUBJECT MAXIMUM SCORED

Environment
Accounting

Computer

O 00 IO\ h s LI N =

s
O

D b md ek ok fradd o ok ok
OO WO~V W

01-SEP-2003 07:35AM

(ii) Entering Numbers (Values)

A number entry must begin with0123 45678 9 +-$ C and decimal point. It
can contain upto 240 characters. It cannot include spacé or commas. It can have not
more than one decimal point. It can begin with a currency symbol ($) or other non alphabetic
currency character and can end with % to indicate a percentage.

When you enter the first character of a number, the mode indicator on the right

of the screen changes from READY to VALUE. A number aligns on the right edge of a
cell.
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For entering the numbers in the above illustration, meve the cursor to B5 to B6
and enter with 100. Similarly move to C5 to C8 cells and enter the scored marks
respectively. It you have to enter labels such as 22", the computer will not accept 1t To
enter a label-prefix character. On entering the values, you get the Spread Sheet as shown

in figure. ,
A Worksheet with label and value entries

C8:75 ' READY|
A B C D E.F G H
;_ MARKS STATMENT
2 SUBJECT MAXIMUM SCORED
5 | Environment 100 65
6 | Accounting 100 60
7 | Banking 100 68
g Computer 100
10
11
12
13
14
15
16
17
18
19
20| 01-SEP-2003 07:40AM
(iii) Entering Formula

A formula is an instruction to calculate with numbers or text. A formulamust begin
with one of the following characters.

0123456789.+(@#8$.
It can contain between 1 to 240 characters. It cannot contain spaces except
within a range name or a text string. It must begin with a plus sign (+).

When you enter the first character of a formula, the mode indicator on the top right
at the screen changes from READY to VALUE. When you complete the formula, the
mode indicator changed back to READY,

When you complete the formula entry, the result appears in the worksheet itself.
For example, if you enter the formula 25+35, after the entry, the value 60 appears in the
cell.

Lotus 1-2-3 allows three types of formulas:

D) Arithmetic formula - Calculate with'numeric values using the
arithmetic operators.
ii) | Text formula - Calculates with label using the text

operators (the ampersand character)



iii) Logical formula Compare values in two or more cells using

the logical operators. A logical formulais g
statement that produces a value, that is either 0
(meaning FALSE) or 1 (meaning TRUE)

To enter the formula, the cell addressing (numbering) is very important. In our

illustration, the formula for calculating the total marks obtained is C5+C6+C7+C8. Thq
formula is eéntered as follows:

— Move to cell pointer to C10
—  Type +C5+C6+C7+C8
—  press

The computer immediately displays the resulti.e., 268 in the corresponding cell.
. The computer does not display the formula in cell C10 but only its results. Once the data
has been entered in a Spread Sheet, 1-2-3 autdmatically recalculates the results of formulas

whenever any figure is changed. On entering the formula, you get the spreadsheet as
shown in figure.

Entering a formula in worksheet

C10: +C5+C6+C7+C8 . - READY
A - B C D E FG H
1 [IMARKS STATMENT
2
2 SUBJECT MAXIMUM SCORED
"5 | Environment 100 65
6 | Accounting - 100 60
7 | Banking 100 68
g Computer 100 . 75
o TOTAL ‘
11
12
13
14
15
16
117
18
19
1201 01-SEP-2003 07:45AM UNDO
7.6 EDITING CELLS

- When you enter data in a worksheet, 1-2-3 left-align label-entries and right-align
values in the cells. If you want to format.a label in cell, you have to use a left-prefix
character, before entering the actual data for cell. The label-prefix are of three kinds.

® * (Apostrope) = leftalignsalabel

(i) * (Quotation mark) - right aligns a label
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(i) A (caret) - centers a label

If you do not type a label prefix character, 1-2-3 automatically. prefixes an
apostrophe (°) to the label. The general display of the label is as follows:

Cabel Prefix Character, Label enteredinthe cell  Display of label in the cell
¢ . ‘TOTAL TOTAL |
“ “TOTAL TOTAL

~ ~TOTAL TOTAL

When you want to enter labels which begin with numeric characters (e.g. 100™
Day), you have to type a label-prefix character before entering such labels. When you
enter an incorrect character is a cell, 1-2-3 change the mode indicator to EDIT and cursor
is positioned at the character it identifies as incorrect. This facilities fo edit the label.

7.6.1 Editing Data in a Cell:

To edit a data in a particular Cell, you have to position the cell pointer in that cell
and press F2 (Edit). To illustrate, the word ‘maximum entered in cell B3 asaleft aligned
one has to be changed to right-aligned label. The movement are as follows.

- Move the cell pointer to cell B3
Control panel displays ‘maximum in the first row
- Press F2 (Edit)

Coritrol panel displays ‘maximum in the second row MADE indicator
changes to EDIT

- Press HOME
Curser moves ¢n in ‘maximum
- Pressdel

To delete’

[19

- Type
Control panel will display “maximum
- Press 0—'
you can see the right aligned maximum in cell B3
7.6.2 Using commands and functions:

1-2-3 has several built-in commands. The commands aze available through a menu

There are two ways of selecting a command in the menu.

@) High lighting the desired command and then pressing !
(i) Typing the first letter of the desired command. -



To invoke the mean pres: / (right slash key) <-1-2-3 displays a menu in the

control panel as follows.
r.___lworgsﬁeetl Range Copy Move File Print Graph Data System Add-in Quit

Global Insert Delete Column Erase Titles Window Statis Page Learn-

Main Menu

Worksheet Mienu Commands

The first line in the menu displays the main menu choices. Initially first choice
(worksheet) is highlighted. The secondline in the menu displays the sub-groups of commands
available under the highlighted choice. You can select other menu using the arrow keys.

7.6.3 Changing column width:

The standard width size of the column is nine characters. If we want to display a
longer label or number, the following steps are followed.

- "Highlight worksheet

- Press «! toselectit

- 1-2-3 displays the following menu
Global] Insert Delete Column, Erase  Tites Window Status Page Learn
Formal Label-Prefix Column-width Recalculation Protection Default Zero

- Press right'arr:w key to highlight column

- Press+! toselectit
- 1-2-3 displays a new menu

Set-width Reset-width Hide Display Column-Range

Specify width for current column

- Press < to select set width

The current width of the column is displayed and prompts for the new
width - “enter column width (1.,240):9”

- Type the new width
- Press «!
The width of the column changed to the new width.
Note: 1)) °  Before changing the column width, the cell pointer must be positioged in.
that column
1) After changing the column width the new column width is displayed.

1-2-3 has meny built-in functions. The functions may be applied to a single cell or
arange (group) of cells. Arange is any rectangle area in a worksheet. A range is defined
by specifying the first and last cell init. When a range includes cells from multiple columns
and rows, the diagonally opposite corner cells are used to specify it. If the range is large,

you can specify the range address by pointing to that area.
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Check your progress
Fill in the blanks
6. -The standard width size
of the column is

__ characters.
7. The @ sum function is
used to calcuate the
___ of numbers
Say true or false
8. Cabols have been
stored in the RAM of the
computor.
9. Ram is non-volatile,

The @ sum functions is used to calculate the sum of numbers in arange. Letus
use this function to calculate Total marks for the range B2..B5 in the illustrated worksheet.

- Move the cell pointer to cell A6 and type TOTAL.
- Press - to move the cell to cell B6.
- type @ sum (B2..B5)
- Press «
1-2-3 displays the sum of marks in cell B6.

The @ IF functions can be used to take decisions based on a condition. Consider

.| the following illustration.

“If the gross total of items purchased is more than Rs.4000, he is entitled to a20%
discount and otherwise a 10% discount”. ’

There are two conditions and two formulas are needed to solve the conditions.

| Since you cannot use two formulas in a cell, youcan use a flexible formula with the @IF

| function. The syntax is.

@ IF (condition, true-value, false-value)
This function check the condition. Ifthe condition is evaluated is true it returns true value,
else, it returns false value. Consider the following function.

@ IF (+B 11>4000, 0.20, 0.10). v '
1-2-3 checks the contents of cell B11. Ifit contains a value which is more than or equal to
4000, it display the true-value (0.20). otherwise it displays the false-value (0.10)
7.7SAVING THE WORKSHEET

The labels and values feeded to the worksheet have been stored in the Random
Access Memory (RAM) of the computer. Since RAM is volatile, the worksheet must be
saved as disk file or ahard disk. The commands for saving and retrieving a worksheet are '

available under FILE in the main menu.
- Press / (or) < toinvoke the main menu.
- select file by highlighting file or pressing F

- press «' todisplay a new menu

Retired Save Combine Xtract Erase List Import Director Admin

F-rase the current worksheet from memory and display the selected worksheet.
] Highlight save '
1-2-3 displays the following message

“Store the entire worksheet in a worksheet file”
- press + to select save

- Assigna name to the worksheet and typeit.




press «
Mode indicator changes to WAIT and after saving the worksheet in the
file itdisplays READY

The worksheet is saved. 1-2-3 automatically adds the extension name “WKI”

to the worksheet files.
7.8 KEY TERMS .

* Spread sheet - A wroksheet used in a computer to create and
analyse interrelated column repe:ts in work
spaces.

* Label - Texual information entered into a worksheet.

* V;11ue - Number entry into a worksheet.

* Cell - An area at the intersection of arow and column.

* Built -in-command - Commands which are stored in the computer for|
easy operation.

* Volatile memory - Memory that loses its contents when power is
shutoff.

7.9 SUMMARY

Spread sheet is an electronic worksheet. One can store ali kinds of information in the
worksheet. Screen consists of three parts viz., control panel, worksheet area and status
line. You can enter data in the form of labels, Numbers and Formula into the spreadsheet.
The label entries are left aligned and the numbers are right aglined. The label Profix are
used to format a label in the cell of the spread sheet. By using the commands and funetions,
you can change the width of the column. After entering the required data, the worksheet is
saved. The system automically adds the extensim name “WKI” to the worksheet files.

7.10 ANSWERS TO CHECK YOUR PROGRESS

1) Electronic  2) Control Panel 3) Status 4)ytext 5)left
6)9 7) total 8T 9F
7.11 QUESTIONS /EXERCISES
Section - A

1. Explain the different parts of screen in sreadsheets.
2. Explain how will you enter label and Number in a Worksheet.

3. Write any 5 statistical and 5 mathematical functions.
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Section - B

4. What are the uses of spread sheets? How will you cl;ange the column width of
Notes a worksheet?
5, Explain how will you edit data in a cell of a spread sheet.
17.12 FURTHER READING

1. PC Software Made Simple - Ravi Kant Taxali -
~ Tata McGraw-Hall publishing company Limited, Ne.w Delhi.

2. LOTUS 1-2-3 Made simple- Ravi Kant Taxali and Pardeep Chopu - Tata

McGraw-Hall Publishing Company Limited, New Delhi.

¥U



—

UNIT-8 GRAPHS

Structure
8.1 Introduction
8.2  Unit Objectives
8.3  Creating Graphs
8.4  Using Dataand Time
8.5 Using Time in Worksheet
8.6  NamingRanges
8.7 Using Statistical Functions
8.8 Using Mathematical Functions
8.9. UsingFinancial Functions
8.10 Key.Tems
8.11 Summary
8.12  Answers to Check Your Progress

8.13  Questions/Exercises

8.1 INTRODUCTION

Worksheets generally contain more numeric data. Hence it becomes different t
accurately analyse them and to take a correct decision. In such cases the facility to represen
data in the form of graphs comes handy. Because graphs convey the message clearly an
quickly. They play a very important role in the business world. Lotus 1-2-3 allows you t

see graphs on the screen as well as to print them on a graphic printer.

8.2 UNIT OBJECTIVES

After going through this unit, you will be able to
o List the different types of graphs that can be created.
e Usedata and time in worksheets
e Use mathematical function in worksheets
e Apply financial functions in worksheets
e . Create and view the required graph.

8.3 CREATING GRAPH

Lotus 1-2-3 supports five different types of graphs viz., Line, Bar, Stacked Bar,

Pie and XY. Creating a graph involves the following steps.
- Activate the graph command
- - Specify the range to be plotted
-  State the graph type
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- Specify options, if required
- View the graph. A
NOTES 8.3.1 Acfivating the Graph Command:

If you want to draw a graph, you have to retrieve the worksheet for which graph
has to be drawn. For example, you can retrieve the marks worksheet. Type

e Select/ Graph
1-2-3 display the graph menu and the graph settiné sheet.

Graph Settings and Menu
Al ] MENU
Type X AB CDE F Reset View Save Options Name Group Quit
Graphs Settings
Type : Line ' Titles : First
X Second
A Xaxis
B Y axis
.C Y Scale: X Scale:
D Scaling Automatic Automatic
E Lower
F Upper
Grid: None Color : No Format G) G)
Indicator Yes Yes
Legend Format : Data tables : Skip: 1

A Both

B Both

C - Both

D Both

E Both

F Both

The graph setting sheet displays the settings for the current graph. At preseft, it
is almost blank. It will display more details when you select it them with the graph menu.

8.3.2 Specifying the range:

We have to define the numeric data which you want to print in the graph. You can
use up to 6 ranges which are numbered A through F. These ranges are called data ranges.
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To begin with you will use the A range to plot the marks for the subjects in the mark
worksheet. The mark figures are stored in the ranges B4. B7., Move the cell pointer to cell
B4 and press - to mark the starting of the range. Use - to move the cell pointer to B7 to
highlight the range B4.. B7. Press « to specify the highlighted as the first data range (A
range). Additional data vatues are specified with the data ranges B-F.

The X-axis in the graph does not represent any numeric data. It is divided into a
number of points equal to the data values in the specified range. The X-axis can be labeledj
to make the graph more expressive. Let us display the subject names through the X datal
range for the marks worksheet graph. Move the cell pointer to cell A4 and select the range,
A4.A7.

Starting the graph type:
1-2-3 provides five types of graphs viz., Line Graph, Bar Graph, Pie Chart and|
XY Graph. You can select any type by using the TYPE command in the graph menu.

8.3.3 Specifying Options:

The appearance of the graph can be improved by including options like graph
titles, legends, data lablels, grids and so on. A graph also can be in color.
8.3.4 Viewing advertising graph:

You can save advertising graph for i) viewing ii) to print on a printer. A graph saved]
for viewing cannot be printed. If you want to save the current graph setting for later viewing,
save the file with / File Save. Whenever you want to view the graph, you can press thej
function key F10 or with / Graph view command. The current graph may be saved with all|
optional settings in a separate graph file. The saved graph file is used to print the graph
through the print Graph features.

Todisplay the graph, select VIEW, when the control panel is displaying the Graph|
" menu. Initially LINE is selected. To select other graph types, use arrow keys to highlight
the desired graph and press + . The different graph for the marks worksheet are as

follows:

LINE GRAPH

Ervironment Accourt - Banking Computer

Graphs
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Check you progress
Fill in the blanks:

1. Worksheets generally'

contains more

data.

2. Lotus 1-2-3 supports
different types

of graphs.

3. Ranges are numbered A

through '

4. Any type of graphs can

be selected by using the

command

Q1







& Environment
# Account

W Banking

# Computer

XY Graphs

XY graphs are different from other graphs. It is also called as a scatter graph. XY
graph plots the correlation between two sets of variables. This type of graph is used to plot
advertisement against sales, weight against height or a correlation between sales and profit.

8.4 USING DATE AND TIME

You may want to use data in a work sheet on various occasions — data of creation,
date of printing, date of appointment of a worker etc. 1-2-3 supports several functions 1tol
enter the date in cells.

Entering the current Date: The function to enter the current date is @ Now 1
e Erase the cusrent worksheet with / worksheet Erase Yes
e Enter @ Nowincell Al |

The computer displays a number rather than the actual date. Each date is representedr
by a unique number which is equal to the number of days elapsed since January 1, 1900.
Generally the date number is not much of use. . Therefore you have to format the cell containing
the date number to display the date in desired format.

e Invokethe 1-2-3 main menu and select Range Format Date 1-2-3 will display

several date formats.
- I (OD-MMM-YY) 2 (DD-MMM) 3 (MMM-YY) 4 (Long Intn’1) 5 (Short Intn’1) Time
tus Standard long form 9

- Initially date format 1 is high lighted .
- Press +! toselectit '
- It prompts to enter the range: Enter range to format: Al...Al

- Press*.
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Since the cunént width (9) is not sufficient to display the date in the selected
format 1-2-3 displays asterisks in cell A1. Hence change the column widthto 11.

- USE / worksheet column Set-width to change the column width to 11, 1-2-3-
displays a date in the DD-MMM-Y'Y format.

" Entering Datesin a worksheet: The range to display the dates can be formatted
before or after entering dates. A particular date can be entered with @DATE.

- Move the cell pointed to the particular cell
- Use/Range format date
- Press + to select the first date format.
- Select the range.
- (@ DATE (year, month, day)
The worksheet now displays the dates in prompt format.

8.5 USING TIME IN WORKSHEET

1-2-3 supports several functions to enter the current or desired time in any cell.

.| The current time can be displayed in a cell with @ Now. To do this, you need to format the

cell for time display after entering @ Now. The hour, minute and second can also be
extracted from time by using 1-2-3 functions. A desired time can be entered with @ TIME.

e Invoke the 1-2-3 main menu and select Range Format Date

e Select the last option in the main menu-Select Time 1-2-3 displays the following

mentu.

1 (HH:MM:SS AM/PM) 2 (HH:MM: AM/PM) 3 (Long Intn’1) 4 (Short Intn’1) Lo
Standard long form

-  Select2

- Press «+' toselect the range

- The current time is displayed in the cell.

8.6 NAMING RANGES

Ranges are used for copying, moving and formatting and they are specified either
by typing the range address or by pointing. This process of typing or pointing may become
cumbersome if you have to use the same range with several commands. In such case, the
easier way is to assign a name to the range. This is called “naming ranges”. The range name
can be used with commands. You can assign names to any number of ranges in a worksheet.
The range name is assigned with the / Range name create command.
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Let us the command on the illustrated PROFIT worksheet.

Al READY
A B C D E F G NOTES -
1 Profit and Loss Statement _
2 APRIL, MAY JUNE JULY AUG SEP
Z Cost 60,000 65,000 75,000 70,000 60,000 80,000
o 5 |Overheads 10,000 15,000 15,000 20,000 20,000 15,000
= ,‘;Sales- 1,00,000 1,10,000 1,25,000 1,30,000 1,00,000 1,26,000
= | g
3 i |Profit 30,000 30,000 35,000 40,000 20,000 31,000
RS
'g 11| Total 6,91,000
= | |12
% i Total Profit 1,86,000
15
16
17
18
19 .
120 29-OCTOBER-2003 8.30 AM

In the given worksheet, the profit figures are entered in range B9..G9 and total
profitin B13. Let us assign the name PROFIT to this range and then use it in functions. The
steps are:

- Select /Range Name
Display will be a follows:
Create Delete Labels Reset Table

Create or modify a range name

- Select create
- Enter PROF IT (in response to the prompt for the range name)
- Enter B9..G9 (in response to the prompt for the range address)
1-2-3 assigns the range B9.G9 to the range name PROFIT

. Now you can use this range name (PROFIT) to calculate total profit.
- Move the cell pointer to cell B13 and enter @ sum (PROFIT)
1-2-3 displays 1,85,000 as the total profit.
You can also create other range names. Let us create for sales.
- Move the cell pointer to cell B7
- Select/Range Name
- Enter SALES
- Enter B7..G.7
- Move the cell pointer to Cell B11 and enter @ sum (SALES)
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Check you progress
Say True or False:

€. Siacked-bar graphs are
similar to bar graphs.

7. Pie chart is more suitabl

to display any variable.

.| 8. XY graphs are called as

line graphs.
9. @AVG is a mathematical

-1 function.
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1-2-3 displays 6,90,000 as the total/sales
To save the defined range names, select/ File save to save the modified PROFIT

worksheet.

1-2-3 functions are classified into nine categories viz., statistical, mathematical,
Date & Time, financial, Database, logical, string, special and Add-in.
8.7 USING SATISTICALFUNCTIONS

_ Statistical functions performs statistical operations on a range of numerical values.
1-2-3 supports the following statistical function.

@AVG - calculate the average of a list of values
@COUNT - counts the non-blank cells in a list of values
@MAX - finds out the maximum value in a list of values
@MIN - determines the minimum value in a list of values
@STD - cafculates the standard deviation ina list of values
@SUM - calculate the sum of the value in a list.

@VAR - calculate the variables of a list of values.

You can also specify multiple ranges with @ SUM functions
Examples:
@ SUM (A1..A4, B1..B4) - Sums up values in ranges A1..A4 and B1..B4
@ SUM (PROFIT, $ SAMPLE) - Sums up values in PROFIT and SAMPLE
INMustration:
Using @ AVG function in the given PROFIT worksheet -
- Move the cell pointer to cell A15 and enter Average Profit
- * Movethe cell pointer to cell B15 and enter @ AVG (PROFIT)
1-2-3 displays 6,100 as the average profit in the cell. .
8.8 USING MATHEMATICAL FUNCTIONS
Mathematical functions perform mathematical operations on numeric data.

" @ABS - Calculates the absolute value of a number
@EXP - Calculates the number e raised to the specified power.
@ INT - - Returns the integral portiorrof a value.
@ LN - Calculates the natural logarithm of the value specified
@ LOG - Calculates the common logarithm of a value
@ MOD - Calculates the modulus (remainder) of two valueé
@RAND - . Returnsarandom number between 0 and 1 every time

the Worksheet is calculated.



@ROUND -

@ SORT -

Rounds off the value to a specified number of decimal
places.

Calculates the square root of a positive number 1-2-3
also has the following trigonometric functions viz.,

@ACOS, @ASIN, @ATAN, @COS, @P1, @SIN and @TAN.

8.9 USING FINANCIAL FUNCTIONS

Financial functions are used to calculate loans, depreciation, cash flow, present

and future value and so on. ‘
@CTERM = - Calculates the number of periods takes for an investment|
to grow to a future value at a givenrate of interest.
@RATE - Calculates the periodic rate of interest for an investment
to grow to a future value over a specified period.
@ TERM - Calculates the number payment periods required to
accommodate the investment to a future value.
@FV - Calculates the future value for annuity eaming a fixed
periodic rate of interest.
@ PMT - Calculates the equal periodic payments required to pay
offaloan.
@ PV - Calculates the present value of annuity to be received in
the future
@ NPV - Calculates the net present of a series of future cash flows
discounted at a fixed interest rate.
@IRR . - Calculates the Internal Rate of Return expected from a
‘series of cash flows occurring at regular intervals. '
8.10 KEY TERMS
. Graphic : A display device that provides the repesntation o%
datain graphic form
. Range The set of values that a quantify, function or
| variable can take
. Statistical functions  : Performs statistical operations on numeric data.
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8.11 SUMMARY

Graphs convey the message clearly and quickly. Lotus 1-2-3 supports line, bar,
staked bar, pie and Xy types of graphs. For drawing graphs, one has to activate the graph
command and has to specify the range, Before printing the graph you can view the graph.
Date and time of creating the worksheet can be made. Ranges can be named and the range
name can be used with commands. 1-2-3 supports statistical functions to perform statistical
operations. Mathematical functions perform mathematical operations on numeric data.

Financial functions are used to calculate loans,depreciation, cash flow and so on.

8.12 ANSWERS TO CHECK YOUR PROGRESS

Check you progress
1. numeric 2. Five 3.F  4.Type
5.T - 6.F 7.F 8.T 9.F

8.13 QUESTIONS/EXERCISES

Section - A
1. Explain how will you generate the line graph in lotus 1-2-3
2. Describe the conéept of Naming ranges in Lotus 1-2-3.
3. Write any five financial functions of Lotus 1-2-3
Section - B
4. Write statistical and Mathematical functions in Lotus 1-2-3 |
5. Explain the procedure for drawing different types of graphs by using imaginary figures.
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UNIT-9 MICROSOFT WORD (MS WORD)

Structure .

9.1. Introduction NOTES
9.2. Objectives
9.3. Starting MS-word
9.4. Document Window
9.5. Editing Document Text
9.6. Formatting Text
9.7. Tables
9.8. Graphics
9.9. Templates
9.10. Wizards
9.11.Key Terms
9.12, Summary
9.13. Answers to check your progress
9.14. Questions/Exercises
9.15. Further Reading
9.0. INTRODUCTION

Window is a powerful operating system. It was a graphical user interface. The
command and syntax need not be memorized as in other operating system. Microsoft
Office (MS Office) includes Word, Excel, Power Point, Access, Outlook, the Office Shortcut
Bar and Office Assistant. In this unit we will mainly discuss about MS Word. MS Word i
a software package offering features for sharing data and documents, communication tools,
internet access and publishing capabilities. You can create letters, memos, reports with the
help of MS Word. It can also help you to send documents to a group of people for
feedback.

9.1 UNIT OBJECTIVES
After going through this unit, you will be able to
*  Open MS-Word

¢ (Createc anew file

* Handle Document Window
» EditText

* Formatting Tables

* Insert Pictures

» Handle Templates and Wizards
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9.4.2 Typing Text and savings:

Once the new document opened we can enter text in the edit window. To save the

file, select file / save or press save buttons. The file will be saved with its current name and
file type. | '
9.4.3 Moving around the document:

For making corrections, one should be able to move to any part of the document.

The place for corrections is denated by blinking vertical bar called insertion point. This
insertion point, to make correction has to be moved either by mouse or by keyboard

operations. The different ways of moving the insertion point (cursor) are

a.

To move to the end of the document —

Mouse: move to the end of the document and click
Keyboard: press [Cul] + [End]Keys

To move to the beginning —

Mouse: move to the beginning of the document and click
Keyboard: press + Ii{ome Keys

To move to the middle of the document —

Mouse: move to the desired place and click
Keyboard: press the arrow keys to reach the desired place.
To move to the next page —

Mouse: The area between the scroll box and the bottom scroll arrow in the
vertical scroll bar can be clicked

Keyboard: press {PgDn | Key

"To move to the previous page —

Mouse: The scroll box in the scroll bar can be dfagged upwards to move to the
previous page.

Keyboard: press|{Pg Up Key

To move tc any page —

Mouse: Open the Find and Replace box by double clicking the status bar. Click

. the ‘Go To’ option move the cursor to the specified space.

Keyboard: press | Cul [+ | G | Keys. Specify the page.

'9.4.4 Correeting and Inserting Text: '

The word to be corrected should be selected by double clicking it with the mouse.

-The word will be highlighted. Now type correct word which will replace the original word.

It a sentence to be changed, place the mouse at the beginning of the sentence click

once. Hold the left button pressed drag the mouse to the end of the sentence and release

-
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the button. Now the whole sentence will be highlighted. Type the new matter and ihe old

one gets erased.

If a word to be deleted, place the cursor of the end of the previous word and
press [ Ctrl || Del |. The word and blank space after the word gets erased.

In an existing document, new text can be inserted. For inserting, the mode must
be in the ‘insert mode’. Move the cursor at the point where text is to be inserted. When

we type the new test, the existing text will move to the right to give room for the entry.

A blank line can be inserted by pressing Enter once. Date and time can also be
inserted, in the documents such as memos and invoices, by using the Date and Time
dialog box.

9.4.5 Printing a document:
- Printer should me made ready. Connect the printer, switch on the printer, place the
papers in the printer
- Click the print preview button and make adjustments if necessary

- Choose File Print from the menu bar to open the print dialog box, select a printer,

choose the number of copies and specify what should be printer.
- Click OK button to print the document.
9.5 EDITING DOCUMENT TEXT
9.5.1 Selecting Text:

After opening the existing file, cursor has to be placed at the beginning of the text
to be selected with the help of the mouse. Although we can drag to select text, word offers
a number of other options by which we can select text smoothly. The following table
exhibits the different kinds of selecting text.

Multiple words, lines

shift-select

To select Do This

A word Double —click anywhere in the word

A sentence Hold ctrl and click anywhere in the sentence

A paragraph Triple click anywhere in the paragraph.

Single line Move the pointer to the left margin. When the printer changes to
aright-pointing arrow, point to the desired line'and click.

Entire document Choose Edit select all from the menu bar or hold ctrl and click in
he left margin

Multiple lines Move the printer to the left margin. With the right-pointing

arrow, point to the first desired line and click. Without replacing
the mouse button, drag to select additional lines.
Move the I-beam into the first word, hold the mouse button,

or sentences drag to the last word, and release
Multiple words, lines | Click the first word, moveto the last word (with mouse button
-jorseniencesusing |, released) hold shift and click. Everything between the two clicks

is selected.




9.5.2 Copying and Moving Text:

Moving text deletes the original and placed it in the new location. Copying text
leaves the original in place and creates a copy in the new location. Cut, copy and paste are
the standard window functions. All the moving and copying techniques work with pictures
or any other objects just as they do with text. The steps for moving or copying text-are as
follows.

- Select the text which you want to move or copy
- Click the cut or copy button on the standard tool bar
- Move the insertion point to where you want the text to appear
- Click the paste button
To move and copy text short distances, it is easy to use a method called dreig-and
-drop.
" Moving text using Drag-and-Drop.
- Identify the text you want to move and its destination
- Select the text and drag it to its new location while holding down the right mouse
button. Drop the selection into position by releasing the mouse button.
- Select Move Here from the standard menu
- Ifyousplit the screen, drag the Resize control to remove the split.
Copying text using Drag-and-Drop-
- Identify the text you want to copy and its destination
- Selecting the text and drag it to new location while holding down to the right mouse
button. Drop the text into position.
- Select Copy Here from the shortcut menu
9.5.3 Using the Undo feature:

While editing word documents, if a wrong action is taken, it can be taken back
with the help of undo feature. Undo feature can be used for all actions like formatting,
deleting, inserting, pasting, cutting and so on. But by clicking the undo button once, only
the action which is done just before the clicking of undo button with be reversed. To
reverse a number of actions performed, say three, undo button should be pressed three
times.

9.5.4 Using the Rado feature:

Redo feature repeats the action that is taken on the document. It is useful when a
number of actions is to be repeated. One action will be repeated by one press. If a number
of actions are to be repeated the button is to be pressed for such a number of items. This

redo feature can be used only for the actions which are reversed by undo option.
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CHECK YOU PROGRESS
Fill in the blanks
1. Microsoft word is a part of

2. Drag and drop method is
easy to move and copy text
1] S WU
distance .

3. Redo feature ....................
the action that is taken on the
document

Say true or false
4. We an enter text in the edit
widow

5. Spelling checker program
is aiso used to check the
documents for problems with
grammer
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9.5.5 Spell and Grammar checker:

Word has a spelling checker program which can be used to check the document
for missplet words. The grammer checker is used to check the documents for problems
with graxﬁmer. The spelling and grammer dialog box gives us all the options. When we type
the text, word will flag misspelled words by placing a wavy red line underneath possible
misspelling. Do right click on a flagged word to open the spell. It pop-up menu, which lists
suggestions for the proper spelling. Click on the correct spelling, choose to Ignore the

word.

9.6 FORMATTING TEXT

. Formatting refers to the changes made to improve the appearance of the
Documents. Use of different margins, line spacing, page numbers, headers and footers
make a document easier to read and also provide important ihformation for the reader.
World has standard format settings. When new document are created, they are arranged
as per these default settings. These default settings can be changed as required.

'19.6.1 Setting Margins:

Word’s default margins are 1 incs on the top and bottom and 1.25 inches on the
left and right sides top and bottom and 1.25 inches on t he left and right sides of the page.
To change margins, use the Margin page of the page setup dialog box and set the option.

Page Setup ;"
Margins | Paper || Layout |
| Margins s . <o
Top: - Bottom: !l" 2%!
§ Left: T | -
. autter:  [0° 2 Gutter postion: [Left ]
OFIBRILALION . # oo s mess scaarts | i 0 2o 3 M A SIS B S 005
]
{mm—m— L..._______...
) Portrait Landscape
Pages el -
Multiple pages: [ Normal s |
Preview - - c v o s owiee s e
Apply to: ———
iiWhOle document g%{ E___:_
_:;
-j/ Defaulk... - xg ok _j I Cancel ]

e L ts 1 1t arvas A tvbeeeLlormcbcir A abt) | eI 20030 P ———] porvm——

Top, Bottom, Left and Right spin box controls set the amount of white space on
the four edges of the document.

- The gutter margin is used to additional space to a document that will be bound.
- The mirror margin feature helps format margins for back-to-back printing.

Changing of document margins can be made as follows-




Position the insertion point where you want the margin changes to take effect.

Choose file Page Setup to open the Page Setup dialog box and click the Margins
tab

Click the Mirror margins check box to activate mirror margins, if desired.
Use the spin box arrows or type the text boxes to increase or decrease the margins.

Click OK to return to the document.

9.6.2 Setting Line Spacing:

Line spacing is the vertical distance between lines of text. Word provides six

options for adjusting line spacing.

Single

Enough space to display the largest character on a line

1.5lines One-and-a-halfsingle lines x

‘Double Twice space as single spacing

At Least A minimum line spacing for the selection

Exactly Makes all lines eventually spaced regardless of the size of the fonts or

graphics included in those line

Multiple Used to enter line spacing other than single, 1.5 and double.

Procedure:

Seiect the text whose line spacing you want to change

Choose Format Paragraph to open the Paragraph dialog box

Click the line spacing drop-down list to select the desired line spacing

If you choose At Least, Exactly or Multiple, enter a number in the At control

Click OK 1o return to the document and revises the changes.

9.6.3 Aligning Text:

Word provides four options for aligning paragraph text viz left, center, right and full

(justify). To align text, position the insertion point anywhere in the paragraph and click one
of the alignment buttons on the formatting toolbar.

9.6.4 Intenting Text:

Intenting is nothing but moving in. Word offers three ways to access the paragraph-

intenting features viz., the formatting tool bar, the ruler and the Paragraph dialog box.

i

i

Formatting tool bar is the easiest method to change intents. Click anywhere in the
paragraph, and click the Decrease Intend button to reduce the left intent by
Y4 inch. Click the Increase Intent button to extent by intent by % inch.

Creating intents using the ruler is a visual way to set left, rights, handing and dual
intents. There are four intents markers as shown in the following diagram.

Microsoft word (MS Word)

NOTES

97



Microsaft word (MS Word)

NOTES

98

Intent markers on the ruler

SLVRN

Lefintent

Rightintent

Steps for intenting usiﬁg the Toolbar and Ruler-

- Click iﬁ the paragraph to intent and click the Increase Intent button or Decrease

Intent button on the Formatting tool bar

- Chose View Ruler

- Select the text to intent

- Drag the First Line Intent marker to the right to intent the first line in a paragraph

- Drag the Hangling Intent marker to the right to intent all but the first line in a

paragraph

- Drag the left Intent marker to intent all the selected text.

- Drag the Right Intent marker to intent the selected text from the right margin.

ii. Indentingusing the Paragraph Dialog box is the third way to set intents. To access
the Dialog box, choose Format Paragraph or right-click and choose paragraph from

the short cut menu.

—— — . -
Indents and Spacing | Line and Page Breaks i

General P eaa . Noa e - - - . "
Alignment: QOutline level: Body text & 5;
Indentation
Left: ) Special: By:
Right: o" | {none) ?'9??% ]; e
Spacing
i Before: Line spacing: At:
After: i Single o i % W%; ]

T Dorte sdd spacs betaesn paragraste of e seie olvie

Preview

ot Test wleigCe Tong ek 545 Sone’s Tost paanple Tonz Seene Tt vagd'c Tons
Sowerge 0 T s warpe Tond St Toat samp e Toxd watgdy Toxa Sune Tros Seee Tone
Saege's Tour veotp T Tews Seatrem Fokh Samgr v Tonz mamgln Tend Suwpie Frox woomi's Toua

. Ia/bs'..., / . . k OK i[ Cancel ]




The steps for intenting is as follows-

Select the text to indent and open the paragraph dialog box.
Use the spin box controls to charge the Left and Right intent settings.
Click and Special drop-down arrow to select First line or Hanging intent.

Click OK to close the paragraph dialog box

9.6.5 Fonts and Font styles:

You can give a professional appearance for the documents by using Windows

applications. The right combination of fonts, font styles, sizes and attributes can make the

documents more attractive.

~ To change the font, click the drop-down arrow next to the font name. To turn on

Bold, Italics or Underline, click the corresponding button on the tool bar. The selected text

will be changed to that font. Font color is available from most tool bars as well as from

the “cn* dialog box. Some new decorate fonts are shown below.

Some new decorative fonts shown in Word

Thisis Dlackadder ITG.

THIS IS CASTELLAR

This is Jokerman.

This is Lucida calligraphy.
Bhis is Rervie.

9.6.6 Creating and Modifying Page numbers:

Page numbers offer a convenience for the writer as well as for the reader The

stepsinvolved are-

pe

T B R

Place the cursor at the beginning of the document
Page numbers option of the Insert menu is selected
The page numbers dialog box appears in the screen
You have four options regarding page numbers _
Position — Bottom of the page or Top of the Page -
Alignment — Left, Center, Right, Inside or Outside
Show numbers on First Page

Format — Open the Page Number Format dialog box. It allows you to choose a
numbering style such as “A, B, C” or “1,2,3” and to include a chapter number, if
you desire.
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- After making the formulating choicé, click OK to return to Page Number dialog
box
- Once again click OK to insert the page number
- To view the page numbers, switch to Print Layout
9.6.7 Handling Page Break:

Word offers an option with the tacky name window/orphan control. This feature
prevents the first line of a paragraph from being left alone at the bottom of the page (an
orphan) or the last line of a paragraph from appearing by itself at the iop of anew page (a
window). You can turn window/orpharn control off in the Line and Page Breaks tab of the
Paragraph dialog box (choose Format > Paragraph > Line and Page Break). The steps for
adjusting line page breaks are — |

- Choose Format > Paragraph > Line and Page Breaks to turn text few option —
widow/orphan Control, Keep Lines Together, Keep with Next, and Page Break

Before on or off.
- Press Ctrl + shift +hyphen to insert a non-breaking hyphen.
- Press Ctrl + hyphen to insert on optional hyphen‘
- Press Ctrl + shift + spacebar to insert a non-breaking space.
9.6.8 Creating Header and Footer:

In addition to the page numbers sfou may want to include other informations —
name of the organization, all right reserved, etc—on each page. For this type of informations,
you can use Header and Footer features. Header is the text that is normally printed at the
top of the page. Footer is the text appears at the bottom of the every page.

To insert a header or Footer, choose View>Header and Footer. The existing
document text will immediately dimmed and the Header text box at the top of the document
will open. Enter the text in the Header text box. Use the Toolbar buttons to create and

- |modify the headers and Footers.

Header and Footer tool bar buttoqs

Button Button Name What It Does
2 e utoTexty . Insert Auto Text Provides drop-down list of Auto
Text entries.

Insert Page Number Inserts page number placeholder g

Inssert Number of Pages  Inserts placeholder for total number of

pages
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Tables can be created in 3 ways viz.,

i. Using the Insert Table button

ii.. Using the Insert Table dialog box and

111 Using the Draw Table button

" To use the Insert Table button, click the button and drag the number of rows and

columns you want 1r} your table. When you release the mouse b}ltton abank table appears.
To create a table using the Insert Table dialog box, choose Table > Insert Table. Enter the
number of rows, columns, and column widths in the appropriate controls and click OK to
create the table. To draw a table, of your options, click the tables and Borders button on

the Standard toolbar. The mouse pointer will change to a pencil. Drag the lines about the
size of a table which you require. When you release the mouse button, the table is created.

9.7.1 Entering and Editing Text

Aﬁef creating the table, text has to be entered. Enter the text by clicking in any cell.
Arrow keys are used to move ﬁohl one cell to another. The procedures for entering,
editing and positioning text in tables are
- Click in any cell and begin typing. Use the Tab key to move one cell to the right,
shift Tab to move to the left and arrow keys to move up and down or left and right.
- Applyany character or paragraph formatting options to the text. Each cell is treated
as a paragraph '
- Click one of the alignment buttons on the Tables and Borders toolbar in reposition
text within a cell :
- Click the change Text Direction button on the Table and Borders toolbar to rotate
text vertically. -
9.7.2 Modifying Table Structures:

Modification of the table is an easy job in word. You can add or delete rows and
columns, change column and row widths and merge and split cells without upsetting the

| rest of the table text. The procedures for modifications are-

- Insert rows at the end of the table by clicking in the last cell.and pressing Tab.
Insert rows in the middle of the table by selecting the mimber of rows to insert and
choosing Table > Inset> Rows Above.or Table > Insert > Rows below.

- Delete rows by selecting the rows to delete and Choosing Table > Delete > Rows.

- Insert columns by selecting the number of columns to insert and selecting Table >
Insert > Columns to the left or Table > Insert > Columns to the right.

- Change the width of the column by pointing to the cell border and dragging the
border with the double headed arrow pointer.
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9.8.1 Modifying Pictures:

After placing a picture from a file, you can adjust the picture using the Picture tool
bar. Right click the picture and choose Show Picture Tool bar from the shortcut menu. The
Picture Toolbar has the following buttons.

*#
p<
A,
et
rey
i

Picture Toolbar Buttons.
Bution Name Use
Insert Picture from File Insert another picture
Image Control Choose from Automatic, Grayscale,
Black & White, or Watermark
More Contrast Increase color intensity
51 Less Contrast Decrease color intensity
w? 1 More Brightness Add White to lighten the colors
Less Brightness Add black to darken the colors
Crop Trim sides of the image
% Line Style Format the border that surrounds the
picture
Recolor Object Change individual colors in the object;
only avilable in Power Point (see Skilll 7)
}fﬁg * # Format Picture One-stop shopping for picture properties
Set Transparent Color Use like an eyedropper to make areas of
the picture transparent (used extensively
for Webrgraphics)
7] ResetPicture Retum the picture to its original format.

T'gle'Crop, Recolor object and set Transport color buttons are used with areas of
the picﬁfre. All other buttons affect the entire picture.

9.9 TEMPLATES
A template is a collection of document formatting options and content that is available

when you create a new document. Every document is based on a template when you
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. Undo - A function that allows a user to cancel a previews command and return to
the state before the command was executed.

. ~ Redo - A function that repeaté the action that is taken place on the document.
. Margin — The space that lies between the text area and the edge of the page or
screen

. Alignment — The process of adjusting components of a system for proper inter

relationship.
. Font —A family of characters of a given size and style.
. . Header - A block of text printed consistently at the top of the pages in adocument
. Footer —A block of text printed consistently at the botj:om (;f the pagesina - |
document.
. Page break —A place where a page ends and a new page begins
« . Template—A collection of document formatting options
. Wizard — words which are frequently wed letter elements.
9.12 SUMMARY

Microsoft Office (MS Office) is a software package that offers new features, for
sharing data and documents. It includes Word, Excel, Access, Power Point, Out look. The
basic components of the default word screen are Title bar, Menu bar, Ruler bar, Status bar,
Work space, Task bar, View buttons and Insertion point.

" Anew file is created by clicking on file new. Once the new document is opened,
you can enter textin the edit window. For making correction one should be able to move
to any part of the document, copying, moving, Undo, feature, Redo feature spell and
grammer check are used to edit the document. Formatting a document includes setting
margins, setting line spacing, aligning text, intenting text, assigning fonts and font sizes.
Headers and Footers are placed to puf respective infromation in a document’s top and
bottom margins. The page numbers are placed in a frame in the header or footer. Tables
are made up of rows and columns of data entered into cells. You can insert graphics, sound
and video in every office application. Template and Wizard are useful to create the
documents. quickly and easily.

9.13ANSWER TO CHECK YOUR PROGRESS

|1) Microsoftoffice ~ 2) short 3) repeats 4HT S)F

6) one 7)four ~  8)three 9T 10)f




9.14 QUESTIONS / EXERCISES
Section - A
Explain the method of selecting, moving and copying text in word
Discuss the margin setting concept in word
Explain the different kinds of selecting text with examples
What are the uses of Redo and Undo features? 4
T Section - B
5. Explain the concept of modifying Table structures in word with your own example.
6. Explain the paragraph formatting features in word With examples.
7. Explain the formatting of text in word |
9.15SFURTHER READING
1. MS Office for every one — sexena — Vikas publications, New Delhi
2. Microsoft office 2007 — LP Editorial Board — Low Point, Kolkata — 01
3. MS Office — C Nellai Kannan — Nels Publication, Tirunelveli.
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10.2 UNIT OBJECTIVES
After going through this unit, you will be able to
e Understand the features of Excel
. Navi gate worksheet
. Make different types of entries in a worksheet
. Format the worksheets
10.3 EXCEL BASIC

10.3.1 Opening Workbook: .

The application window opens with a new Excel workbook. A workbook is af
multi-page Excel document. Each page in a workbook is called a worksheet. The active
worksheet is displayed in the document window. Worksheet is divided into columns, rows|
and cells. Each worksheet has 256 columns and 65536 rows. A cell is the interaction oﬁ
arow and column. Each cell has a unique address composed of the cell’s column and row,
The active cell has a bax around it called the cell pointer. The cell pointer can be moved{

from one cell to the other by using the arrow keys.
.10.3.2 Selecting worksheet items:

Worksheet items viz., cells, rows and columns have to be selected for entering

data, makiﬁg corrections, and changing the width of column or row.
- Acellisselected by clicking the cell. The cell border is highlighted. Cell address{
appears in the name box of the formula bar. Cell content appears in the co,ntentsl

area of the formula bar.

- Range isthe group of adjacent cells. To select the range, place the pointer at the
first cell and by pressing and holding down the left button, the mouse is dragged tow
the lost cell of the range and the button is releaed.

- Acolumn orarow can be selected by clicking the column heading or row headiné
in the worksheet frame.
- The entire worksheet can be selected by clicking the select All button.
10.3.3 Entering Text and Numbers:

You can enter three types of data in a worksheet viz., numbers, formula and text.
Numbers are values used in calculations, including dates. Formulas are calculations. Text
is an entry which is not a number or a formula. To enter the data in the cell, first activate the
cell and type the data. As soon as you begin entering data from the keyboard, three things|
happen - an insertion point appears in the cell, the entering text appears in the cell and the
formula buttons are activated. Excel has an Auto complete feature that keeps track of textﬁ
entered in a column and can complete other entries in the same column.
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Fill in the blanks
1. A group of cells on

" * | which an opeation is to be

performed is known as

2. You can enter
types of data in a
worksheet

3. Filling is a kind of

Say True or False

4, Microsoft Excel is an
electronic spreadsheet.
5. Cell is an area at the
intersection of a row and
column
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10.3.4 Revising Text and Numbers:

You can change an entry in a cell intwo ways. Activate the cell and type the new
entry, the old entry will be replaced. To delete the contents of a cell completely, activate
the cell and then press the Delete key on the keyboard or right click and choose clea

contents from the shortcut menu.
10.3.5 Working with Numbers:
Excel was standard computer operator symbols for mathematical and logical. They

are.
" Operation Operator symbol

Addition : ' +
Subtraction -

| Multiplication *
Division /
Exponentiation A
Precedence enclose in ()
(Do this operation first)
Equal to =
Not Equal to <
Greatgrthan >
Lessthan - <
10.3.6 Creating Formulas:

You can create formulas in number of ways. Simple formulas are created in two
ways. viz a point-and-click method, and worksheet approach method. In a point-and-
click method formulas are entered as follows. )

- Activate the cell where the result to appear
- Type =
- Click on the first cell where you want to include in the formula
- Type an operator
- Click on the next cell in the formula
- Repeat the previous two steps until the entire fonnul.a is entered.
- Finish the entry by pressing Enter or clicking the Enter between onthe
formula bar.

In the spreadsheet approach method, type the formula using the cell addresses of
each cell you want to include in the formula.




10.3.7 Filling Formulas:

Filling is a kind of copying. The formula may be the same for many calculations.
For example the formula for each employees pay is the same, hours *pay rate. Since youw
have already created one working formula, you can fill itto the other cells.

- Select the cell that contains the formula you want to copy to other cells.

- Drag the fill handle to select the cells where you want the formula copied. A

- Release the fill handle to fill the formula.

10.3.8 Totaling Columns and Rows:

Excel has the Auto Sum button on the standard toolbar for creating row and column|
totals.

- Select the cells that contain the numbers you want to total and a blank row
and /or column to hold the totals.

- Click the Auto Sum button on the standard tool bar.

Ifyou want to have a blank row/column before the total, select two blank cells.

“Excel always places the total in the last empty cell selected.
Formatting Numb;:rs: ‘

Formatting is used to identify numbers as currently or percentages and to make
numbers easier to read by aligning decimal points in acolumn. You can format selected]
cells using the Formatting tool bar, the Format cells dialog box, or the Shortcut menu.

" The formatting tool bar is the toolbar displayed on the right side of the Personal|
Tool bar. Formatting affects only the display of a cell, not the cell’s contents. Using the
Formatting toolbar has the following procedures.

- - select the cells to be formatted.
- Click a button on the Formatting toolbar to apply a format to the selected)

cells.
- Click on any cell to turn off the selection.

Format cells dialog box has more number of formulas. After selecting the cells toJ
be formatted open the dialog box either by choose Format > Cells from the menu bar or
right click to open the shortcut menu and choose Format Cells.
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Set the available options, such as the color of text and the background of]
cells.

Click the OK button to apply the format and close the dialog box.
10.4 REARRANGING WORKSHEET ‘

Changes or adjustments in the layout has to make the worksheet attractive.
Adjustments have to be made in inserting or deleting the rows, columns and cells. Naming

a worksheet is essential. These will give way for useful presentation.
10.4.1 Adjusting Column width and Row height:

Excel column are slightly more than eight character wide. If the data which are tof
be entered in the worksheet is wider or much narrower than the existing column, you have|
to adjust the column. You can adjust column width manually or use AutoFit column width|
to the existing data. You can adjust the row height in the same way of adjusting column|
width. The procedure is.

- select the column to adjust

- Position the mouse pointer at the right edge of selected column heading
- Double click

- Click anywhere in the worksheet to turn off the selection.

- - To adjust column width manually, drag the right border o1 a column s
heading to make the column wider or narrower.

10.4.2 Inserting and Deleting Rows and Columns

When you require columns in between the current columns you have to insert them
and when you have empty columns or unwanted columns, they have to be deleted.

- Select the row or column where the new inserted column to appear

- Right click and choose insert to insert a row. To insert a column from the
menu bar Choose Insert > columns.

- To delete a column or row, first select it. Then right click and choose
Delete or Choose Edit > Delete from the menu bar.

10.4.3 Inserting and deleting cells:

Sometimes you have to add or delete cells in part of a worksheet without inserting|

or deleting entire rows and columns. Select the range where new cells to be inserted and
then right-click and choose Insert. Open the Insert or Delete dialog box. If you choo
shift Cells Down, the cells in a selection and all Cells below them in the same column are|
shifted. If you choose shift Cells Right, Cells in the same row (sentence) are moved to the

right.
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10.4.4 Moving and Copying Cell contents

If you want to move or copy data from one worksheet to another cut or copy the
selection and then click the sheet tab for the sheet you want to past into. Click in-the
appropriate cell and then press Enter to paste. For moving and copying cell contents from
one worksheet to another, both workbooks must be opened. This process also could be
done with Drag-and-Drop method.
10.4.5 Naming a Worksheet:

A work book is a multi-page document. Each pageina wofk book is called a
worksheet. It is practically difficult to remember which sheet contains what data. Excel
allows you to give a descriptive name to each worksheet to enable you to locate it instantly

within the work book. For naming a worksheet.
- Double-click the sheet tab to select it
- Type anew name for the worksheet
- Press Enter

10.4.6 Selecting Worksheet:

You can move, copy, delete and enter data in selected worksheets, When more
than one worksheet is selected, the worksheets are grouped. Data entered into one sheet
is entered into all sheets in the group. When entries are finished, immediately youhave to
ungroup worksheet to avoid overwriting. The procedure is. ‘ '

- - Toselectone worksheet, click the select tab

- - To select more than one worksheet, hold the ctrl key while selecting each
worksheet

- To select all worksheet in a workbook, right click on any tab and close
Select All Sheet from the short-cut menu

- To ungroup worksheets, right click on any grouped worksheet tab and
choose Ungroup Sheet from the short-cut menu.

10.5 EXCEL FORMATTING

You can enhance the appearance of the worksheet by using some other formatting
options.
10.5.1 Aligning Text

By default, Excel left-aligns text and right-aligns numbers. You can override the
default by using the buttons on the Formatting tool bar and align text and numbers at the
left, center or right within cells. By clicking the Alignment page table you can choose
horizontal alignment, vertical alignment, rotating text, merge and wrap options.




10.5.2 Borders and Color:

Borders and colors highlight the information in the worksheet. Fill coloris used to
highlight the background of part of worksheet and font coloris applied to text. The Borders,
Fill color and Font color buttons are available on the Formatting tool bar. ~

10.5.3 Printing:

Before printing, you have to setup the margins, page, headers, and footers, sheet

and see print preview to know how each page of the worksheet will appear when it is|

‘ printed. Page setup dialog box is used for this purpose.
10.5.4 Page Settings:
- Open the Page set up dialog box
- Change setting for orientation, scaling, Paper size, Print Quality
-+ Click OK to apply the settings.
10.5.5 Header and Footers:

A header appears at the top each page and footers are printed at the bottom of the
page. The default setting has no header or footer. You have to create them.

- Choose File>Page setup from the menu bar
- Select the Header/Footer page.
- Click the Header drop-down list and select a header or click custom
Header. Click the Footer drop-down and select a footer or click Custom
Footer.
- Press Enter to return to the Page Setup dialog box.
10.5.6 Margins settings:

The preview in the Margin page of the page setup dialog box displays the margins
as dotted lines. The margins can be changed by using the spin box controls.

10.5.7 Sheet settings:

The sheet paée contains settings that relate to the sheet features that will appear in
the printed copy After choosing File > Page setup, specify ranges for a Print Area and
rows and columns to be repeated as titles on each prlnted page by entering them from the
keyboard or by using mouse.

10.5.8 Page Break Preview:

Page Break Preview is a view of the worksheet window that shows as what will
be printed and the order in which the pages will be printed. You can change the range to be
printed by dragging the edge of the page break with the mouse to extent or limit the range
of cells to be printed.
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10.5.9 Print Settings:

To choose a printer to specify what to print and to set the number of copies you
have to open the Print dialog box.

- Choose File > Print to open the Print dialog printer from the printer box

- Select a printer from the printer Name drop-down cbntrol

- Select what to print

- Setup the number of copies using the copies Spin box

- Specify a page rang
- Click OK to print.
10.6 KEY TERMS
. Spread Sheet - A programme that displays a worksheet in which table
consisting of rows and columns.
. Cell - An area at the intersection of arow and column in a
: ' spreadsheet.
. Range - A group of cells on which an operation is to be
' performed.
. Operating Mode- Indicates for operation currently being performed.
10.7 SUMMARY

Spreadsheet is a software which simulates a paper worksheet. MS Excel is a
window-based spreadsheet package. Movement in the worksheet is possible by using the
lgeyboard, mouse or the scrol{bars. Data entry can be of text, numbers, data and time.
Saving a workbook saves all the worksheets contained in it. Making modification in
worksheet is possible. It can be done by editing a cell or a cell range. Copying and moving
data from one place to another in a worksheet can be done. Worksheet can be inserted
and renamed, and deletion of these worksheets is also possible. Numeric formatting feature
lets you change ihe appearance of the numeric entries. Column width can be changed by
using format, Column, Width options. Row height can be altered by using Format, Row,
Height options. Alignment of data in your worksheet can be controlled. Borders tab in the
format call dialog box enables you to apply borders. To ¢hoose a printer, to specify what
to print and to set the number of copies, you have to open the print dialog box.

9.13 ANSWERS TO CHECK YOU PROGRESS -
1) Cell range 2) three 3) Copying 4HT 5T
6) Worksheet .7 Allsheets 8)left DT 10)F
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9.14 QUESTIONS/EXERCISES
' Section - A
1. Describe the various formatting of text in cells.
2. Explain how will you select worksheet items in Excel with example.
: NOTES

3. Explain how will you create formula in Excel with example.
4. Write the steps for creating formulas in Excel.
Section - B
5. How will you insert and delete rows and columns in Excel? Explain with example.
6. Describe the methods of adjusting column width and row height in Excel wi

example. :
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UNIVERSITY QUESTIONS

COMPUTER APPLICATIONS IN BUSINESS - MAY 2007
(f‘or those who joined in July 2003 and after)

Time : Three hours Maximum : 100 marks
SECTION A - (4 x 10 = 40 marks)

Answer any FOUR questions:

1. What are the characteristics features of Computers? Explain.

2. How will you plali and implement the MIS‘7 Explaixz |

3. Define data processing. How does the term data differ from information?

| 4. Explain any two forms of inbut statements in BASIC with example.

5. Describe the method for entering labels in Lotus 1-2-3 cell with example.

6. Discuss any five built-in functions in Lotus 1-2-3 with example.

7. Explain any five buttons on picture toolbar in Word in detail.

8. How will you insert and delete rows and columns in Excel? Describe with examples.

SECTION - (3 x 20 = 60 marks)

Answer any THREE questions:

9. Draw a block diagram of a computer. Explain its components in detail.

10. Explain the elements and functions of MIS in detail.

11. What are the different business applications of data processing? Explain them in detail.

12. Describe the different types of loop statements in BASIC with example.

13. Explain the different methods for editing document text in Word.

14. (a) Discuss how will you create formula in Excel with example.

(b) Describe how will you format numbers in different ways in Excel.



COMPUTERAPPLICATIONS IN BUSINESS - OCTOBER 2008
(For those who joined in July 2003 and-after)
Time : Three hours Maximum : 100 marks
SECTION A - (4 x 10 = 40 marks)
Answer any FOUR questions:
1. Explain the memory unit with figure.
2. Describe the functions of MIS in an organization.
3. Define data processing. How dces the term data differ from information?
4. Discuss any two férms of input statements in BASIC with example.
5/. Write the required steps to change the column width of a cell in Lotus 1-2-3 with
Allustration.
6. Explain the steps for entnrlng current data and time in Lotus 1-2-3 worksheet.
7 Discuss the method for setting margms in Word.
8. How will you insert and delete rows and columns in Excel? Describe with examples.
SECTION B - (3 x 20 = 60 marks)
~Answer any THREE questions:
9. Explain the different stages involved in establishing the MIS in detail.
10. Discuss the various stages involved in data processing.
11. Describe the diffbrent types of loop statements in BASIC with example.
12. Explain the different parts in blank worksheet of Lotus 1-2-3 with neat diagram.
1 3 Discuss the different m;ethods for indenting text in Word with examples.
14. Describe the various formatting options in Excel with example. '
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